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IMPORTANT NOTICE 
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products supplied by Meggitt Sensing Systems are based on information believed to be reliable, but 

unless otherwise expressly agreed in writing with Meggitt SA, the accuracy or completeness of such 

data is not guaranteed. Before using this product, you must evaluate it and determine if it is suitable 

for your intended application. Unless otherwise expressly agreed in writing with Meggitt SA, you 

assume all risks and liability associated with such use. Meggitt Sensing Systems takes no 

responsibility for any statements related to the product which are not contained in a current English 

language Meggitt Sensing Systems publication, nor for any statements contained in extracts, 

summaries, translations or any other documents not authored and produced by Meggitt Sensing 
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PREFACE 

 

About these release notes 

This document provides important information about the VibroSight ® software from Meggitt Sensing 

Systems. It is applicable to all VibroSight-based condition monitoring and machinery protection 

systems using the versions of software described by this document, namely: 

 VibroSight software version 3.0.0 (CD part number 609-004-000-037). 

This document contains information about changes to the software since the previously released 

version (VibroSight 2.12.7), such as new features and improvements, solved problems and bug fixes, 

and hardware and software compatibility. 

For more general information on the actual software, or the entire condition monitoring system (CMS), 

refer to the following Meggitt Sensing Systems (MSS) documentation: 

 VibroSight software data sheet 

        (MSS document ref. 660-020-005-219A) 

 Getting started with VibroSight installation guide 

        (MSS document ref. 660-010-006-217A) 

 VibroSight help 

 XMV16 / XIO16T extended vibration monitoring card pair data sheet 

        (MSS document ref. 660-020-010-209A) 

 VibroSight application notes and technical notes. 

 

Users who are familiar with VibroSight may also find it useful to refer to the release notes included in 

earlier versions of the software: 

 VibroSight 2.9.0 (MSS document ref. VIBROSIGHT-RN/E) 

 VibroSight 2.9.1 (MSS document ref. VIBROSIGHT-RN/E) 

 VibroSight 2.9.2 (MSS document ref. VIBROSIGHT-RN/E) 

 VibroSight 2.9.4 (MSS document ref. VIBROSIGHT-RN/E) 

 VibroSight 2.9.5 (MSS document ref. VIBROSIGHT-RN/E) 

 VibroSight 2.9.6 (MSS document ref. VIBROSIGHT-RN/E) 

 VibroSight 2.9.7 (MSS document ref. VIBROSIGHT-RN/E) 

 VibroSight 2.10.0 (MSS document ref. VIBROSIGHT-RN/E) 

 VibroSight 2.10.1 (MSS document ref. 660-010-013-201A) 

 VibroSight 2.11.0 (MSS document ref. 660-010-013-203A) 

 VibroSight 2.11.1 (MSS document ref. 660-010-013-204A) 

 VibroSight 2.11.2 (MSS document ref. 660-010-013-205A) 
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 VibroSight 2.11.3 (MSS document ref. 660-010-013-206A) 

 VibroSight 2.11.4 (MSS document ref. 660-010-013-207A) 

 VibroSight 2.11.5 (MSS document ref. 660-010-013-208A) 

 VibroSight 2.11.6 (MSS document ref. 660-010-013-209A) 

 VibroSight 2.12.0 (MSS document ref. 660-010-013-210A) 

 VibroSight 2.12.1 (MSS document ref. 660-010-013-211A) 

 VibroSight 2.12.2 (MSS document ref. 660-010-013-212A) 

 VibroSight 2.12.3 (MSS document ref. 660-010-013-213A) 

 VibroSight 2.12.4 (MSS document ref. 660-010-013-214A) 

 VibroSight 2.12.5 (MSS document ref. 660-010-013-215A) 

 VibroSight 2.12.6 (MSS document ref. 660-010-013-216A) 

 VibroSight 2.12.7 (MSS document ref. 660-010-013-217A). 

 

Structure of the release notes 

This document presents information in the following order: general items first, then in terms of the 

software modules that constitute VibroSight, such as  Configurator,  Event Viewer,  Mimic, 

 Scope,  Server,  System Manager and  Vision. 

You should read those sections that are most relevant to you and then keep the document for future 

reference. 

 

Version identifiers 

A complete VibroSight software version number has four components that provide the following 

information: 

 Major release identifier: x.x.x.x 

 Minor release identifier: x.x.x.x 

 Update release identifier: x.x.x.x 

 Maintenance (build) release identifier: x.x.x.x 

For each scheduled release of VibroSight, at least one of the first three digits changes (x.x.x.x). 

For unscheduled releases, that are occasionally required to solve urgent problems, only the fourth 

digit changes (x.x.x.x). 

The version identifiers for installed software appear in the Help About box (obtained using 

Help > About … in any VibroSight software module). 
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Terminology 

To distinguish between the different Meggitt Sensing System products that can be used with the 

VibroSight software, the following terminology is used in this document: 

 VM600 card – to refer to the VibroSight-software compatible cards that are installed in a VM600 

rack. The currently available VM600 cards that are designed for operation with the VibroSight 

software are the XMx16 card pairs (XMC16 / XIO16T, XMV16 / XIO16T and 

XMVS16 / XIO16T) and the new CPUR/IOCR card pair. 

Where CPUx card is used in this document, it refers to CPUM and CPUR cards, and where 

IOCx card is used in this document, it refers to IOCN and IOCR cards, unless otherwise stated. 

Where XMx16 card is used in this document, it refers to XMC16 / XIO16T, XMV16 / XIO16T and 

XMVS16 / XIO16T cards, unless otherwise stated. 

 VibroSmart module or VibroSmart device – to refer to VibroSight-software compatible modules 

or devices that are used in a distributed monitoring system. The currently available VibroSmart 

modules and devices that are designed for operation with the VibroSight software are the 

VSI010, VSN010 and VSV300. 

Where VibroSmart module is used in this document, it refers to the VSI010 and VSV300 

modules, unless otherwise stated. 

Where VibroSmart device is used in this document, it can refer to the VSN010 device only, or to 

the VSI010 and VSV300 modules and the VSN010 device, unless otherwise stated. 
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1 Licensing 

In general, the licence required to enable purchased product options remains unchanged between 

update or maintenance level releases. For example, from version 2.12.6 to version 2.12.7. 

However, a new licence is required for upgrades between major or minor level releases. For example, 

from version 2.12.x to version 3.0.x. 

NOTE: VibroSight 3.0.0 is a major level release and requires a new licence key file. 

To obtain a new VibroSight licence key file or for further information on licence keys, contact Meggitt 

Sensing Systems customer support. See 7 Customer support. 

 

2 Features 

General 

VibroSight 3.0.0 introduces two important new features that significantly improve overall system 

performance: 

 Full support for VibroSight historical data repositories. 

 Full support for 64-bit computing. 

VibroSight is now very fast! 

 

2.1 Full support for VibroSight historical data repositories 

VibroSight 3.0.0 introduces full support for VibroSight historical data repositories. 

VibroSight historical data repositories are a specialised system of files designed and optimised for the 

high-speed storage and retrieval of data generated by high-performance machinery monitoring 

systems. It is a proprietary data repository system, consisting of VibroSight historical data folders 

(*.vshdf) for the handling and logging of data by a VibroSight Server, and VibroSight historical data 

archives (*.vshda) for the display, analysis and sharing of historical data without a VibroSight Server. 

VibroSight historical data repositories and the optimised data handling implemented by the VibroSight 

software significantly reduce the performance bottlenecks associated with the use of standard 

databases: 

 VibroSight data repositories are much faster and very responsive when analysing large 

quantities of measurement data. 

 VibroSight data repositories permit the super-fast display of data in VibroSight Vision. 

 VibroSight data repositories result in smaller file sizes, requiring less hard disk space to store 

and share the same quantity of information. 

NOTE: The use of VibroSight historical data repositories replaces the use of 

databases based on Sybase® SQL Anywhere required by previous versions of 

VibroSight. 
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Therefore, it is important to note that: 

 New machinery monitoring projects created with VibroSight 3.0.0 will automatically use VibroSight 

historical data repositories. 

 Existing machinery monitoring projects created with versions of VibroSight earlier than 

VibroSight 3.0.0 must be manually migrated from Sybase SQL Anywhere databases to VibroSight 

historical data repositories before they can be used with VibroSight 3.0.0. 

NOTE: The manual migration of an existing machinery monitoring project to 

VibroSight 3.0.0 is described in detail in the “Data migration” section of the latest 

 Getting started with VibroSight installation guide 

(MSS document ref. 660-010-006-217A). 

 

2.2 Full support for 64-bit computing 

VibroSight 3.0.0 introduces full support for 64-bit computing. 

VibroSight is now separately compiled and made available as 64-bit software (“x64 native”) that runs 

on 64-bit Windows and as 32-bit software (“x86 native”) that runs on 32-bit Windows. 

This allows the 64-bit version of VibroSight to take full advantage of the power of 64-bit computing, 

notably: more physical memory, more continuous memory and a faster bus architecture, resulting in a 

greater overall application speed. These are important gains, particularly for demanding machinery 

monitoring systems such as large-scale vibration applications and combustion applications, but there 

are other benefits too, such as security improvements and a longer lifespan for new projects, leading 

to a lower total cost of ownership 

 Previously, VibroSight was available as 32-bit software only that could run on both 32-bit and 64-bit 

Windows, which allowed VibroSight to take advantage of the increased memory available on 64-bit 

Windows (up to 192 GB for 64-bit Windows 7 compared to a maximum of 4 GB for 32-bit Windows 7). 

 

2.3 New VibroSight installer 

As VibroSight 3.0.0 introduces full support for 64-bit computing, the VibroSight software is now 

available as 64-bit software for 64-bit Windows and 32-bit software for 32-bit Windows. 

Accordingly, the VibroSight installer has been completely reworked in order to include and support the 

different versions of VibroSight 3.0.0 (64-bit and 32-bit) and the changed VibroSight software 

prerequisites (Microsoft .NET Framework 4.6, Microsoft Visual C++ Redistributable Package for Visual 

Studio 2015 and OPC Core Components Redistributable). 

NOTE: The 64-bit version of VibroSight can be installed on 64-bit Windows computers 

only. The 32-bit version of VibroSight can be installed on 32-bit Windows 

computers only. Only a single version of VibroSight can be installed and exist on a 

computer at any one time. 

 

Refer to the latest  Getting started with VibroSight installation guide for further information. 
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2.4 Duration counters 

Duration counters are a new feature intended to be used to provide information about how long a 

machine spends operating above a predefined threshold. This can be an important indicator of the 

degradation that a machine is suffering during operation and can be particularly useful in combustion 

applications for monitoring wear or hydro applications for monitoring cavitation. 

Basically, a duration counter provides a cumulative measure of the time that a measurement spends 

above a predefined threshold during the operation of the machine. 

Duration counters are implemented as post-processing, that is, the processing is performed by a 

VibroSight Server. 

 

Duration counters and alarms compared 

A duration counter configured for a measurement (extracted data entity) is used to see when the 

measurement passes a threshold level and for how much time the measurement is beyond the 

threshold. When the measurement drops below the duration counter threshold level, the duration 

counter pauses but “remembers” for how long the measurement was beyond the threshold, so when 

the measurement passes the threshold again, the duration counter continues from where it was. In 

this way, a duration counter provides a complete record of how long a measurement spent beyond a 

predefined level during the operation of a machine. That is, duration counters are cumulative. 

In comparison, a 1D Fixed Limit alarm (severity level) configured for a measurement is used to see 

when a measurement passes a threshold level, which can be used to trigger an alarm (severity state) 

notifying the user, and to see for how much time the measurement is beyond the threshold. When the 

measurement drops below the alarm threshold level, the alarm condition ends, so when the 

measurement passes the threshold again, a new separate alarm starts. In this way, an alarm provides 

an individual record of one occasion when a measurement went beyond a predefined level during the 

operation of a machine. That is, alarms are not cumulative. 

 

How to use duration counters 

Duration counters are used in a VibroSight machinery monitoring application in the following way: 

 VibroSight Configurator – used to configure duration counters. 

 VibroSight Server – used to enable/disable duration counters and log duration counter data. 

 VibroSight Vision – used to display and analyse duration counter data. 

 

How to configure duration counters 

To configure duration counters in VibroSight Configurator: 

1. Configure a VibroSight Server Configuration as usual (input channels, processing blocks, 

extractions and data entities) or open an existing configuration. 

2. In the Hardware view, at the VibroSight Server node level, right click then click New Duration 

counters processing block in order to add a duration counters processing block. 

3. Select the new duration counters processing block, then configure its parameters as follows: 
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Name: Enter a name for the duration counters processing block, such as “Duration counters 

processing block 1”. 

State: Enable or disable the duration counters processing block in the configuration. 

Update rate: Select the update rate for the duration counters processing block, that is, how often 

the duration counters processing block will run and provide updated data. 

Note: 10 s is the fastest update rate for duration counters. 

Note: Duration counter data is generated by post-processing running on the VibroSight Server. 

4. At the Duration counters processing block node level, right click then click New Duration 

counters group in order to add a duration counters group. 

5. Select the new duration counters group, then configure its parameters as follows: 

Name: Enter a name for the duration counters group, such as “Duration counters group 1”. 

State: Enable or disable the duration counters group in the configuration. 

Measurement: Displays the data entities available in the configuration that can be selected for this 

duration counters group. Use this control to select the data entities to include in the duration 

counters group. 

The available data entities can be displayed as either a Hardware view or a Machinery view. 

Under the Measurement list, a count of the number of data entities available, visible and 

selected for the duration counters group is displayed. The Show selected only contol can be used 

to limit (filter) the data entities displayed to the selected data entities only. 

6. At the Duration counters group node level, right click then click New Duration counter in order to 

add a duration counter. 

7. Select the new duration counter, then configure its parameters as follows: 

Name: Enter a name for the duration counter, such as “Duration counter 1 %PB %DE %TH”. 

Note: When naming a duration counter, variables can be used to include information about the 

source processing block (%PB), source measurement (%DE (data entity)) and selected threshold 

value (%TH) used by the duration counter. 

State: Enable or disable the duration counter in the configuration. 

Physical quantity: This box is automatically populated depending on the measurement or entities 

selected for the duration counters group that contains the duration counter. 

Qualifier: If required, select a qualifier (rectifier) for the duration counter. The qualifiers available 

depend on the measurement or measurements selected for the duration counters group that 

contains the duration counter. 

Threshold: Enter a threshold (limit) value for the duration counter. 

When the value of the measurement or entities selected for the duration counters group that 

contains the duration counter is greater than or equal to the threshold, the duration counter starts. 

When the value of the measurement or entities selected for the duration counters group that 

contains the duration counter is less than the threshold, the duration counter stops. 

8. Run a consistency check on the configuration and correct any errors. 

NOTE: Once a duration counter has been added to the Hardware view of a configuration, it 

is effectively treated like any other static measurement by VibroSight. So a duration 

counter can be: 

 Added as a (measurement) point in the Machinery view of VibroSight 

Configurator. 
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 Added as a measurement (data entity) to a data logging rule in the Data 

Storage view of VibroSight Configurator. 

 Displayed in a plot using VibroSight Vision. 

 

9. Activate the configuration. 

 

How to enable duration counters 

To enable duration counters for a VibroSight Server: 

In the VibroSight Server, on the main window, under Server Features, ensure that the Duration 

counters control is enabled. 

or 

In the VibroSight System Manager, from the VibroSight Hosts tree structure of the System Explorer 

window, select and log in to the VibroSight Server, and under Post Processing, ensure that the 

Duration counters control is running. 

 

How to display duration counters 

To display duration counter data in VibroSight Vision: 

In the VibroSight Vision Hardware view, select the VibroSight Server or duration counters processing 

block node level in the tree structure in the top pane in order to see the corresponding duration 

counters (measurements) in the bottom pane. 

or 

In the VibroSight Vision Machinery view, select the facility unit, machine unit, shaft or duration 

counters processing block node level in the tree structure in the top pane in order to see the 

corresponding duration counters (measurements) in the bottom pane. 

In the VibroSight Vision Hardware view or Machinery view, double-click the duration counter 

measurement in the bottom plane to display the duration counter data in a Trend plot (the most 

appropriate type of plot). The VibroSight Vision Time Range should set to Live data or Custom 

historical as appropriate. 

 

10. To display the duration counter data in any type of plot cable of displaying static data, create the 

plot (File > Add New Plot > … Plot) then add the measurement to the plot, for example, by 

double-clicking or dragging. 

NOTE: In VibroSight Vision, irrespective of the data update interval set for “live” data or the 

data logging rate (configured in VibroSight Configurator) and used by “historical” 

data, the data update rate and effective resolution for duration counters is the 

update rate that was configured for the duration counter (>10 s) in VibroSight 

Configurator. 
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 VibroSight Configurator 

2.5 Updated VibroSight Configurator 

VibroSight Configurator has been updated in order to provide full support for the VibroSight historical 

data repositories and 64-bit computing. 

 

2.6 New Standard update rate parameter 

Measurement devices such as the VM600 XMx16 cards and the VibroSmart VSV300 module now 

include a new parameter, Standard update rate, that can be configured in order to limit the fastest 

data rate between the device and a VibroSight Server for live data and data logging. 

NOTE: The Standard update rate parameter affects only the data update rate for 

connections between the measurement device and a VibroSight Server. 

The maximum data update rate (100 ms) always remains available for a direct 

connection to the device in order to display live data in VibroSight Vision and for 

Alarm Event Based data logging rules. 

 

The standard update rate for a measurement device is configured in the Hardware view, at the 

measurement device node level (XMx16 card, VibroSmart VSV300 module) using the Standard 

update rate control. 

See also 2.7 New Consistency check. 

 

2.7 New Consistency check 

The Consistency checker has been improved to include a check that the configuration of 

measurement devices such as the VM600 XMx16 cards and the VibroSmart VSV300 have enough 

on-device buffer memory so that the maximum data update rate (100 ms) can always be supported, 

thereby ensuring the correct operation of a system. 

See also 2.6 New Standard update rate parameter. 

 

2.8 Data logging rule changes 

The data logging rules available for use in the Data Storage view have been consolidated to the 

following: 

 Time Based – recommended for the logging of data at fixed time intervals, with optional 

conditions. 

 Value Based – recommended for the logging of data depending on the value or change in value 

of a particular measurement, with optional conditions. 

 Alarm Event Based – recommended for the logging of data depending on the severity level or 

levels associated with a particular measurement. Also used by the direct measurement mode 

(Direct Mode). 
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The data logging rules are configured in the Data Storage view, at the data storage group level. 

(Previously, there were also Alarm Refinement and Step Changed data logging rules.) 

 

2.9 Data aging rule changes 

The data aging rule available for use in the Data Storage view is no longer required and has been 

removed. 

(Basically, the data management requirements of a VibroSight machinery monitoring application are 

better managed using the VibroSight System Manager Data Repositories commands. See 2.17 Data 

repositories commands.) 

The data aging rule was configured in the Data Storage view, at the data storage group level. 

 

 

 VibroSight Event Viewer 

2.10 Updated VibroSight Event Viewer 

VibroSight Event Viewer has been updated in order to provide full support for the VibroSight historical 

data repositories and 64-bit computing. 

 

 

 VibroSight Mimic 

2.11 Updated VibroSight Mimic 

VibroSight Mimic has been updated in order to provide full support for the VibroSight historical data 

repositories and 64-bit computing. 

 

 

 VibroSight Scope 

2.12 Updated VibroSight Scope 

VibroSight Scope has been updated in order to provide full support for the VibroSight historical data 

repositories and 64-bit computing. 
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 VibroSight Server 

2.13 New VibroSight Server 

VibroSight Server has been completely reworked in order to provide full support for the VibroSight 

historical data repositories and 64-bit computing. 

 

The new VibroSight Server works with VibroSight historical data folders (*.vshdf) only: 

 New machinery monitoring applications automatically create and use a VibroSight historical data 

folder (*.vshdf) as the VibroSight data repository. 

 Ongoing machinery monitoring applications, created with versions of VibroSight earlier than 

VibroSight 3.0.0, must be migrated from using a VibroSight database (*.vshdf) a VibroSight 

historical data folder (*.vshdf) as the VibroSight data repository. 

 

Because VibroSight Server now works with VibroSight historical data folders (*.vshdf) only, it has 

are significantly improved overall data handling and data logging capabilities. 

 

2.14 Seamless data handling at data logging at 100 ms 

The new VibroSight Server supports the seamless data handling and data logging of all static and 

dynamic data provided by VibroSight-compatible hardware (VM600 XMx16 cards and VibroSmart 

modules) at data update rates up to 100 ms. 

(Previously, the VibroSight Server supported a data update rate of 1 s, so for applications that needed 

to display and refresh data as quickly as possible, a direct connection to measurement devices such 

as the VM600 XMx16 cards and the VibroSmart VSV300 module as required.) 

See also 2.25 Plot update rate at 100 ms and 2.6 New Standard update rate parameter. 

 

2.15 VibroSight Server user interface 

The new VibroSight Server has an improved user interface so the way of working with VibroSight 

Server has also changed. 

The new VibroSight Server user interface implements a multiple window tabbed document interface 

with a Status tab and a Log messages tab. 

 

Status tab 

As shown in Figure 1, the Status tab consists of four main areas. 
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Figure 1: VibroSight Server user interface – Status tab 

 

 A general information area – providing general information on the VibroSight Server. 

 A Server features area – providing controls to enable or disable specific features of the 

VibroSight Server: Basic math, Air-gap, Combustion monitoring, Duration counters, Data 

logging manager and Direct data manager. 

For example, the Data Logging manager used to enable/disable data logging. 

 A Device drivers area – providing controls to enable or disable specific drivers of the VibroSight 

Server: VM600, VibroSmart, OPC and Modbus. 

For example, the VM600 and VibroSmart drivers used to enable/disable communications with 

VM600 XMx16 cards and VibroSmart modules respectively. 

 A Server status area – providing detailed information on the status and performance of the 

VibroSight Server and the underlying computer, that is, performance counter monitors. 

 

The Server status indicators (performance counter monitors) is a new feature that can be used to 

monitor the overall performance of the VibroSight Server and the underlying computer, using the 

following metrics: 

 Storage disk usage – a percentage (%) that indicates how hard the computer operating system 

and hard disk drive are working to handle all of the read/write accesses required by the VibroSight 

system. 

 Storage disk full – a percentage (%) that indicates the amount of hard disk space used on the 

computer running the VibroSight Server. 

 Data manager usage – a percentage (%) that indicates how hard the VibroSight Server software 

is working to perform all of the data handling required by the VibroSight system. 
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 Data manager queue length – a percentage (%) that indicates how much data is in a queue 

waiting to be handled by the Data Manager. 

 Server memory usage –a measure (MB) that indicates how much of the computer system’s 

memory (RAM) the VibroSight Server is using. 

 CPU usage – a percentage (%) that indicates how much of the computer system’s processor 

(CPU) the VibroSight Server is using. 

 Data logging manager usage – a percentage (%) that indicates how hard the VibroSight Server 

software is working to perform all of the data logging required by the VibroSight system. 

 Data logging manager queue length – a percentage (%) that indicates how much data is in a 

queue waiting to be processed by the Data logging manager. 

NOTE: The actual VibroSight Server status indicators (performance counter monitors) 

displayed depends on the Server features enabled and running. For example: 

 The Data logging manager usage and Data logging manager queue length 

indicators are only displayed when the Data logging manager is enabled. 

 The Combustion monitoring post processing usage and Duration 

counters post processing usage indicators are only displayed when enabled 

(using the appropriate control in the Server features area) and the 

configuration contains these features. 

 

The VibroSight Server status indicators (performance counter monitors) can be displayed either 

graphically or numerically. 

When displayed graphically, the recent history of values of the indicator are displayed as a plot against 

time and the latest value of the indicator is displayed as a numerical value. When displayed 

numerically, the latest value of the indicator is displayed as a numerical value. 

By default, the status indicators are displayed graphically (Tools > Options: User interface, Display 

mode: Graphic mode). 

 

 

Log messages tab 

As shown in Figure 2, the Log messages tab consists of a list of messages and controls for filtering 

the messages that are displayed. 
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Figure 2: VibroSight Server user interface – Log messages tab 

The list of messages displayed provides detailed information on the status of the VibroSight Server 

and other system components that it communicates with, such as VibroSight-compatible hardware 

(VM600 XMx16 cards and VibroSmart modules), VibroSight data repositories, VibroSight software 

clients, external interfaces and the underlying computer. 

Individual type of message tabs can be used to selectively filter the messages in order to display (or 

hide) any combination of individual types of message: Fatal, Error, Warning, Info, Debug and Trace. 

A Clear all button can be used to clear (delete) all of the currently displayed messages. 

A search box can be used to selectively filter the messages in order to display only the measurements 

containing the search term. 

 

 

 VibroSight System Manager 

2.16 Updated VibroSight System Manager 

VibroSight System Manager has been updated in order to provide full support for the VibroSight 

historical data repositories and 64-bit computing. 

 

2.17 Data repositories commands 

The VibroSight System Manager Data repositories commands (and their command-line equivalents) 

have all been updated to support the VibroSight historical data repositories (VibroSight historical data 

folders (*.vshdf) and VibroSight historical data archives (*.vsdha)). See 2.1 Full support for 

VibroSight historical data repositories. 
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The following VibroSight System Manager Data repositories commands are now available: Copy, 

Summary, Database update and Purge. 

(Previously, there was also a Database backup command, but it is no longer required and has been 

removed. Basically, a VibroSight data repository can now be backed up by copying and pasting the 

VibroSight data repository files (that is, VibroSight historical data folder (*.vshdf) and the associated 

Storage subfolder) using Windows Explorer.) 

 

The VibroSight System Manager Copy command can be used to selectively: 

 Copy data in a VibroSight historical data folder (*.vshdf) to a VibroSight historical data archive 

(*.vshda). 

 Copy data in a VibroSight database (*.vssrvdb) to a VibroSight historical data archive 

(*.vshda). 

 Copy data in a VibroSight database (*.vssrvdb) to a VibroSight database (*.vssrvdb). 

 

The VibroSight System Manager Summary command can be used to selectively: 

 Summarise the data in a VibroSight historical data folder (*.vshdf). 

 Summarise the data in a VibroSight historical data archive (*.vshda). 

 Summarise the data in a VibroSight database (*.vssrvdb). 

 

The VibroSight System Manager Database update command can be used to selectively: 

 Update the underlying structure of a VibroSight database (*.vssrvdb). 

 

The VibroSight System Manager Purge command can be used to selectively: 

 Purge data in a VibroSight historical data folder (*.vshdf). 

 

Command-line tool equivalents of the Copy, Summarise and Purge commands are available for use 

by data management batch files in order to allow a task scheduler, such as Windows Task Scheduler, 

to automate the management of VibroSight data repositories on a computer. 

NOTE: Because of the changes to the VibroSight System Manager Data Repositories 

commands, and in particular, the underlying changes to the command-line options 

for the Copy and Purge commands, it is highly recommended that any existing 

data management and system backup procedures for a VibroSight machinery 

monitoring system are checked and modified as necessary in order to ensure that 

they continue to work correctly with VibroSight 3.0.0. 

Typically, such VibroSight data management procedures include batch files using 

the vibrosightdatacopy.exe, vibrosightextractsummary.exe and/or 

vibrosightdatapurge.exe commands with command-line options that are run 

by Windows Task Scheduler. 
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2.18 Data repositories Copy and Purge commands 

The command-line equivalents of the Data Repositories Copy and Purge commands have been 

changed to use a command configuration file (“*_config.xml”) to configure the majority of the 

options used by the command. 

(Previously, the Copy and Purge commands did not use a separate command configuration file, as 

the command line or Windows batch file (*.bat) used to run the command contained all of the 

options.) 

For the Copy and Purge commands, a Windows batch file (*.bat) and the command configuration 

file (“*_config.xml”) are created by running the command in VibroSight System Manager and 

using the Save to batch file control. These files are intended for use with a task scheduler, such as 

Windows Task Scheduler. 

NOTE: Because of the changes to the VibroSight System Manager Data Repositories 

commands, and in particular, the underlying changes to the command-line options 

for the Copy and Purge commands, it is highly recommended that any existing 

data management and system backup procedures for a VibroSight machinery 

monitoring system are checked and modified as necessary in order to ensure that 

they continue to work correctly with VibroSight 3.0.0. 

Typically, such VibroSight data management procedures include batch files using 

the vibrosightdatacopy.exe, vibrosightextractsummary.exe and/or 

vibrosightdatapurge.exe commands with command-line options that are run 

by Windows Task Scheduler. 

 

In addition, a command configuration file (“*_config.xml”) that was previously generated and 

saved when running the Copy command in VibroSight System Manager can be subsequently opened 

using the Copy command in VibroSight System Manager. This allows an existing command 

configuration file to be checked and/or edited and used as the basis for a new copy command. 

See also 2.22 Align offset time. 

 

2.19 Data repositories Copy with data reduction 

The Data Repositories Copy command and its command-line equivalent now supports two data 

reduction features that can be optionally enabled when copying a data repository: one for static 

measurement data (such as variables) only and another for dynamic measurement data (such as 

waveforms, spectra and orbits) only. 

 

When using the Copy command, static measurement data reduction can be enabled when prompted 

to Select options concerning data reduction: 

 Select Perform data reduction (for variables only) to make the data reduction algorithm 

controls available. 

The data reduction algorithm can be configured to copy the Minimum value and/or the Maximum 

value and/or the First value for the time period specified using the Copy value(s) every 

n msec/sec/min/hour/day/week control.. 
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NOTE: When copying a VibroSight data repository, these data reduction options affect 

static measurement data (such as variables) only. 

More specifically, for all of the static measurement data selected to be copied, the 

data reduction algorithm keeps only the selected values from the selected time 

period, which is repeated throughout the overall time range to be copied. 

 

When using the Copy command, dynamic measurement data reduction can be enabled when 

prompted to Configure your output options: 

 Select the Use 2 bytes format for dynamic data control to reduce the size of the copied data 

repository. 

NOTE: When copying a VibroSight data repository, these data reduction options affect 

dynamic measurement data (such as waveforms, spectra and orbits) only. 

More specifically, for all of the dynamic measurement data selected to be copied, 

using 2 bytes for each measurement point (rather than VibroSight’s native 4 bytes) 

reduces the size of the copied data repository, at the expense of the dynamic 

range of the measurement data. 

 

2.20 IP address binding 

When a VibroSight Server is created, its default behaviour is to “listen” for incoming client connections 

on all available network connections (network adapters). However, in certain applications, such as a 

multi-LAN environment, this default behaviour can be changed using IP address binding so that the 

VibroSight Server only uses the fixed IP address belonging to a specific network adapter. 

When IP address binding is required, the VibroSight Server configuration file 

(EditableServerConfiguration.xml) must be manually edited to include the fixed IP address to 

use. 

(Previously, when IP address binding was required, the VibroSight Server’s configuration file 

(*.vssrvcfg) had to be manually edited to include the fixed IP address of a specific network card.) 

NOTE: It is highly recommended to make a backup copy of the VibroSight Server 

configuration file (EditableServerConfiguration.xml) before manually 

editing it. 

Such manual edits must be done carefully in order to ensure that the tags and 

delimiters used in the VibroSight Server configuration file are used correctly. 

 

To use IP address binding with a VibroSight Server: 

1. Exit (close) the VibroSight Server that requires IP address binding, so that its configuration file can 

be edited. 

2. On the host computer, use an XML-compatible text editor program to open the VibroSight Server 

configuration file (EditableServerConfiguration.xml). 
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NOTE: The default location for the VibroSight Server configuration file is in VibroSight’s 

default data folder (data path directory), typically, C:\VibroSight Data\Data 

repository\Storage\ServerConfiguration\EditableServerConfiguration.xml, 

where Data repository is replaced with the name of the required VibroSight 

Server/VibroSight data repository. 

 

3. Find and edit the line containing the text string UsedNetworkCardIpAddress as follows.  

By default, IP address binding is not used and the line in the configuration file should be: 

<Property Name="UsedNetworkCardIpAddress" Value="255.255.255.255" 

Type="System.Net.IPAddress" /> 

To use IP address binding, change the line in the configuration to be: 

<Property Name="UsedNetworkCardIpAddress" Value="xxx.xxx.xxx.xxx" 

Type="System.Net.IPAddress" /> 

The change (Value="xxx.xxx.xxx.xxx") tells the VibroSight Server the specific IP address to 

use, where xxx.xxx.xxx.xxx is replaced with the required IP address (in dot-decimal notation). 

NOTE: When Name="UsedNetworkCardIpAddress" Value="255.255.255.255", 

the VibroSight Server defaults to “listen” for incoming client connections on all 

available network connections (network adapters) before selecting an IP address to 

use. 

If an invalid IP address binding occurs for any reason (for example, the IP address 

not being configured at the level of a LAN controller, or being configured correctly 

but with the required Ethernet cable disconnected), the VibroSight Server will 

default to operation without IP address binding 

 

4. Save the VibroSight Server configuration file, ensuring that the file name extension (*.xml) is not 

inadvertently changed.  

5. Restart the VibroSight Server. 

The VibroSight Server starts, using IP address binding, and communicates with the associated 

hardware (VM600 cards and/or VibroSmart DMS modules) as before. 

In the VibroSight Server window, the IP address used by the VibroSight Server is displayed under 

Connection. For example, xxx.xxx.xxx.xxx:55xxx, where xxx.xxx.xxx.xxx is the IP address 

used. 

 

2.21 TCP port binding 

When a VibroSight Server is started, its default behaviour is use a TCP port number starting at 55000 

for communication with VibroSight clients. However, in certain applications this default behaviour can 

be changed using TCP port binding so that the VibroSight Server always uses a specific fixed TCP 

port number. 
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When TCP port binding is required, the VibroSight Server configuration file 

(EditableServerConfiguration.xml) must be manually edited to include the fixed TCP port 

number to use. 

NOTE: It is highly recommended to make a backup copy of the VibroSight Server 

configuration file (EditableServerConfiguration.xml) before manually 

editing it. 

Such manual edits must be done carefully in order to ensure that the tags and 

delimiters used in the VibroSight Server configuration file are used correctly. 

 

(Previously, when TCP port binding was required, the VibroSight Server’s configuration file 

(*.vssrvcfg) had to be manually edited to include the fixed TCP port number to use.) 

 

To use TCP port binding with a VibroSight Server: 

1. Exit (close) the VibroSight Server that requires TCP port binding, so that its configuration file can 

be edited. 

2. On the host computer, use an XML-compatible text editor program to open the VibroSight Server 

configuration file (EditableServerConfiguration.xml). 

NOTE: The default location for the VibroSight Server configuration file is in VibroSight’s 

default data folder (data path directory), typically, C:\VibroSight Data\Data 

repository\Storage\ServerConfiguration\EditableServerConfiguration.xml, 

where Data repository is replaced with the name of the required VibroSight 

Server/VibroSight data repository. 

 

3. Find and edit the two lines containing the text string TcpIpPort as follows.  

By default, TCP port binding is not used and the lines in the configuration file should be: 

<Property Name="TcpIpPort" Value="55000" Type="System.Int32" /> 

<Property Name="IsTcpIpPortFixed" Value="false" Type="System.Boolean" /> 

To use TCP port binding, change the lines in the configuration to be: 

<Property Name="TcpIpPort" Value="55xxx" Type="System.Int32" /> 

<Property Name="IsTcpIpPortFixed" Value="true" Type="System.Boolean" /> 

The first change (Value="55xxx") tells the VibroSight Server the specific TCP port to use, where 

55xxx is replaced with the required TCP port number. 
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The second change (Value="true") tells the VibroSight Server to TCP port binding, that is, use a 

fixed TCP port number. 

NOTE: When Name="IsTcpIpPortFixed" Value="false", if the TCP port selected 

by the VibroSight Server (using Name="TcpIpPort" Value="55000" as the 

starting point) is not available, the VibroSight Server will use the next available 

TCP port (starting with Value + 1, and so on). 

When Name="IsTcpIpPortFixed" Value="true", if the TCP port specified 

for the VibroSight Server (using Name="TcpIpPort" Value="55xxx") is not 

available, the VibroSight Server will report an error and will not start. 

 

4. Save the VibroSight Server configuration file, ensuring that the file name extension (*.xml) is not 

inadvertently changed. 

5. Restart the VibroSight Server. 

The VibroSight Server starts, using TCP port binding, and communicates with the associated 

hardware (VM600 cards and/or VibroSmart DMS modules) as before. 

In the VibroSight Server window, the TCP port number used by the VibroSight Server is displayed 

under Connection. For example, xxx.xxx.xxx.xxx:55xxx, where 55xxx is the TCP port number 

used. 

 

2.22 Align offset time 

The align offset time is a fixed time period used by VibroSight Server and VibroSight System Manager 

when calculating the actual time range to be used by the VibroSight System Manager Data 

repositories Copy command, when the Last and the Align to full periods controls are used. 

Basically, the align offset time is a time buffer that allows for the data handling and data logging 

performed by the VibroSight Server, in order to ensure that the data is available in the VibroSight data 

repository when the VibroSight System Manager Copy command runs. 

The align offset time is defined in the VibroSight Server configuration file 

(EditableServerConfiguration.xml) which must be manually edited to change the default align 

offset time value of 20 minutes, if required. 

NOTE: It is highly recommended to make a backup copy of the VibroSight Server 

configuration file (EditableServerConfiguration.xml) before manually 

editing it. 

Such manual edits must be done carefully in order to ensure that the tags and 

delimiters used in the VibroSight Server configuration file are used correctly. 

 

To change the align offset time used by VibroSight Server and VibroSight System Manager: 

1. Exit (close) the VibroSight Server that requires a different align offset time, so that its configuration 

file can be edited. 
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2. On the host computer, use an XML-compatible text editor program to open the VibroSight Server 

configuration file (EditableServerConfiguration.xml). 

NOTE: The default location for the VibroSight Server configuration file is in VibroSight’s 

default data folder (data path directory), typically, C:\VibroSight Data\Data 

repository\Storage\ServerConfiguration\EditableServerConfiguration.xml, 

where Data repository is replaced with the name of the required VibroSight 

Server/VibroSight data repository. 

 

3. Find and edit the line containing the text string AlignedCopyOffset as follows. 

By default, the align offset time is 20 minutes and the line in the configuration file should be: 

<Property Name="AlignedCopyOffset" Value="PT20M" Type="System.TimeSpan" /> 

The value can be changed to have any value between 0 seconds and 1 hour: 

<Property Name="AlignedCopyOffset" Value="PTxxx" Type="System.TimeSpan" /> 

The change (Value="PTxxx") tells the VibroSight Server the specific align offset time to use, where 

xxx is replaced with the align offset time. For example: 

 Value="PT20M" specifies an align offset time of 20 minutes (M designates minutes). This is the 

default value. 

 Value="PT0H" specifies an align offset time of 0 hours (H designates hours). 

 Value="PT0M" specifies an align offset time of 0 minutes (M designates minutes). 

 Value="PT0S" specifies an align offset time of 0 seconds (S designates seconds). 

 Value="PT1H" specifies an align offset time of 1 hour (H designates hours). 

 Value="PT60M" specifies an align offset time of 60 minutes (M designates minutes). 

 Value="PT3600S" specifies an align offset time of 3600 seconds (S designates seconds). 

4. Save the VibroSight Server configuration file, ensuring that the file name extension (*.xml) is not 

inadvertently changed. 

5. Restart the VibroSight Server. 

The VibroSight Server starts, using the new align offset time, so the next time that a VibroSight 

System Manager Data repositories Copy command using the Align to full periods control is run, the 

new align offset time will be used. 

See also 2.18 Data repositories Copy and Purge commands. 
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 VibroSight Vision 

2.23 Updated VibroSight Vision 

VibroSight Vision has been updated in order to provide full support for the VibroSight historical data 

repositories and 64-bit computing. 

 

2.24 Working with multiple VibroSight historical data archives 

VibroSight Vision can now open and work with multiple VibroSight historical data archives (*.vshda) 

at the same time. 

A new Data Source Manager is now used by VibroSight Vision to select the data source, which can be 

either: a single VibroSight Server (VibroSight Server), one or more specific VM600 XMx16 cards 

and/or VibroSmart modules (Devices) or one or more VibroSight historical data archives (Historical 

data files). 

NOTE: Only a single type of data source is currently supported at any one time: either a 

VibroSight Server (VibroSight Server), or one or more specific VM600 XMx16 

cards and/or VibroSmart modules (Devices) or one or more VibroSight historical 

data archives (Historical data files). 

That is, it is not yet possible to combine different types of data source in a 

VibroSight Vision project. 

 

To change the data source used by a VibroSight Vision project, either: 

 In VibroSight Vision, start the Data Source Manager using the File > Data source manager 

command or the connection to the data source on the status bar (far right) of the VibroSight Vision 

user interface, then use the Data Source Manager to add and/or remove data sources 

(VibroSight Server, Devices or Historical data files. 

 In a Windows Explorer, drag and drop one or more VibroSight historical data archive (*.vshda) 

files to a running VibroSight Vision software client. 

The VibroSight historical data archives will be automatically added to the Data Source Manager 

and used by the VibroSight Vision project. 

 

When VibroSight Vision is using more than one VibroSight historical data archive (*.vshda) file as 

the data source, VibroSight Vision automatically analyses the configurations contained in each file so 

that they can be intelligently merged for display in the Hardware view and Machinery view tool 

windows, in order to make the display and analysis of the data easier. For example: 

 VibroSight Vision can detect if different historical data archive files are from the same VibroSight 

machinery monitoring system, in which case, the configurations are merged and displayed as a 

single configuration in the Hardware and Machinery views. 

 VibroSight Vision can detect if different historical data archive files are from different (or 

significantly changed) VibroSight machinery monitoring systems, in which case, the configurations 
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are not merged but displayed as two separate configurations in the Hardware and Machinery 

views. 

NOTE: Different historical data archive files from the same VibroSight machinery 

monitoring system are quite common when a good data management process 

is in place. 

For example, it is recommended that the VibroSight historical data folder 

(*.vshdf) used by a VibroSight Server is regularly copied to create backups 

of older data (in VibroSight historical data archives (*.vshda)), before the 

older data is purged from the VibroSight historical data folder. 

In this way, the complete operating history of a machine can be viewed using a 

number of VibroSight historical data archives, covering sequential time ranges, 

that are easy to manage and share. 

 

2.25 Plot update rate at 100 ms 

VibroSight Vision now supports a plot update rate of up to 100 ms when displaying live data via a 

VibroSight Server for measurement devices such as the VM600 XMx16 cards and the VibroSmart 

VSV300 module. 

This improvement is primarily possible because VibroSight Server has significantly improved overall 

data handling and data logging capabilities. 

(Previously, VibroSight Vision only supported a plot update rate of 100 ms for VM600 XMx16 cards 

when displaying live data from a direct connection to a single card.) 

 

To display live data via a VibroSight Server for measurement devices such as the VM600 XMx16 

cards and the VibroSmart VSV300 module in VibroSight Vision plots with faster update rates: 

 Ensure that the Time Range tool window is in Live data mode and use the Interval controls to set 

the data update between 100 ms and 1 s. 

NOTE: In VibroSight Configurator, the Standard update rate parameter limits the data 

update rate for the data source, that is, connections between a measurement 

device and a VibroSight Server. 

 

NOTE: The Interval controls for Variables and for Waveforms, Spectra and Orbits can 

be separate or combined, depending on the options displayed in the Time Range 

tool window. 

 

VibroSight Vision displays and updates its plots as fast as it can with a typical rate of 100-300 ms, with 

the actual rate depending on the VibroSight Vision configuration, computer performance, card 

configuration and network traffic. 

For VibroSight Vision plots with update rates faster than 1 s (100 ms to 1 s), the resolution of the 

timestamps used by the plot increases to include a millisecond indicator, that is, from 12.25.24 

(hh.mm.ss) to 12.25.24.1 (hh.mm.ss.ms). For example, this includes the timestamp displayed in the 
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top of a plot (corresponding to the plot’s latest measurement data) and the timestamps in displayed in 

the legend of a plot (for example, corresponding to the plot’s cursors) latest measurement data)  

When the computer running VibroSight Vision is not powerful enough to update the plots at the 

selected update rate, VibroSight Vision will “catch up” and display all of the available data when the 

plot is next updated as the underlying buffers used in the background capture the measurement data 

from the card at the maximum data rate (100 ms). Similarly, if a plot is exported, the exported image 

and/or data will contain all of the available data from the buffers. 

See also 2.14 Seamless data handling at data logging at 100 ms and 2.6 New Standard update rate 

parameter. 

 

 

2.26 Display of machines states in the Trend plot 

The Trend plot has been updated to include an additional small chart at the top of the plot document 

window displaying the machine states that correspond to the measurement data displayed in the plot. 

If machine states (machine operating conditions) have been configured in the Machinery view and are 

applicable to the measurement data displayed in a Trend plot, then the machine state information is 

automatically displayed in the Trend plot by default. 

 

If machine states are not required in a Trend plot, the properties of the plot can be changed in order to 

not display them: 

1. Display the plot properties (right-click the plot, then click Plot properties, or Plot > Plot 

properties menu command) dialog box. 

2. On the General tab, under Layout, clear the Machine states control to hide the machine states, 

then click Apply or OK. Similarly, select the Machine states control to display them. 

 

Alternatively, the default plot settings for the Trend plot can be changed in order to not display 

machine states in Trend plots by default: 

1. Click the Tools > Options menu command. 

2. The Options window for VibroSight Vision is displayed. 

3. Under Default Plot Settings in the Options window (left pane), select Trend plot. 

4. In the default plot settings for the Trend plot displayed in the Options window (right pane), under 

General, clear the Machine states control in order to hide the machine states by default, then 

click OK. 

The updated default settings configured for Trend plots will be used the next time that a new Trend 

plot document window is created. 

 



     

 
 

   

     

 

     
 Release Notes VIBROSIGHT-RN/E (660-010-013-218A) 

Release 3.0.0 – November 2016 31 / 66  

     
 

2.27 Data export from the Trend plot 

The export of data from a Trend plot has been updated to include full support for data export to the 

CSV file format (*.csv). 

 

 

2.28 New Long Waveform plot 

A new plot type – the Long Waveform plot – has been added to the catalogue of plots available in 

VibroSight Vision. 

The Long Waveform plot provides an additional way to display and analyse the waveforms from 

measurement devices such as the VM600 XMx16 cards and the VibroSmart VSV300 module. 

Basically, the Long Waveform plot joins together all of the individual waveforms available for a 

measurement point (channel) in order to display them as a continuous long-duration waveform. 

NOTE: The Long Waveform plot displays a single long waveform against time for the 

selected Time Range. The single long waveform consists of all of the individual 

waveforms for the selected Time Range, joined together. 

The Waveform plot displays a series of individual waveforms against time for the 

selected Time Range. The individual waveforms display either 0 to 8 revolutions of 

the measurement or the whole acquired waveform, depending on the plot 

properties. 

 

To add a Long Waveform plot, either: 

 Click the  Long Waveform plot icon on the VibroSight Vision toolbar. 

 Use the File > Add new plot > Long Waveform plot VibroSight Vision menu command. 

 Use the Add new plot > Long Waveform plot command in the VibroSight Vision Project Explorer 

tool window and (right-click on a View and use the shortcut menu that appears). 

 

To add measurement data to a Long Waveform plot: 

 Select a Waveform measurement in the Hardware view or Machinery view and drag it to the Long 

Waveform plot. (A Time Range must also be selected before VibroSight Vision can display a plot.) 

NOTE: Currently, the Long Waveform plot can only display waveforms acquired using the 

fixed frequency sampling mode (that is, waveforms acquired using the order 

tracked sampling mode cannot be displayed). 

 

 

Super-fast data display in VibroSight Vision 

When working with Long Waveform plots, it is worth noting the improved overall system performance. 

VibroSight is now very fast − especially for the display of data in VibroSight Vision! 
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This is a direct result of full support for VibroSight historical data repositories and the optimised data 

handling implemented by the VibroSight software, and full support for 64-bit computing. 

Whenever a plot is updated in VibroSight Vision (for example, creating a new plot, changing the time 

range settings or zooming an existing plot), VibroSight automatically processes (“filters”) the 

measurement data using super-fast algorithms in order to optimally select the measurement data 

points required to accurately display the data in the plot. 

NOTE: When VibroSight Vision is using a VibroSight Server as a data source (that is, a 

VibroSight historical data folder (*.vshdf)), the super-fast data display algorithms 

are run by the VibroSight Server. 

When VibroSight Vision is using a VibroSight historical data archive (*.vshda) as 

the data source, the super-fast data display algorithms are run by VibroSight 

Vision. 

 

Because of the optimised data handling, the quantity of data that is required to be handled by 

VibroSight Vision each time that a plot is drawn or redrawn is dramatically reduced, so the time 

required to display plots is significantly improved. Obviously, this performance is more noticeable and 

important when dealing with larger data sets from more complex machinery monitoring systems and/or 

many, many years of data. 

 

Application tips and tricks 

The long-duration waveform displayed in Long Waveform plots is intended to be used to quickly find 

information contained in the amplitude or envelope (shape) of a waveform. This can be an important 

tool to help spot changes in the operating state of a machine in combustion applications or to track the 

evolution of machinery run-ups and coast-downs in vibration applications. 

The particular data of interest can then be displayed and analysed in more detail by zooming in on the 

Long Waveform plot or by using other plot types. 

Accordingly, a useful way of working with Long Waveform plots is in combination with a (standard) 

Waveform plot, and with cursor synchronisation between the plots. 

For example, navigating through the Long Waveform plot using the cursor, automatically updates the 

individual waveform displayed in the (standard) Waveform plot. And vice versa (with the order 

reversed). 

 

2.29 Data export from the Long Waveform plot 

The export of data from a Trend plot includes full support for data export to the CSV file format 

(*.csv). 
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2.30 New Spider plot 

A new plot type – the Spider plot – has been added to the catalogue of plots available in VibroSight 

Vision. 

The Spider plot (also known as a radar plot) provides an additional way to display and analyse the 

data from measurement devices such as the VM600 XMx16 cards and the VibroSmart VSV300 

module. 

Basically, the Spider plot is suitable for the display of scalar measurement data from three or more 

measurement points (channel) on axes starting from the same point at the centre of the plot in order to 

allow the data to be easily compared and contrasted. Spider plots can be particularily useful to help 

identify measurement data that is similar and/or outlier values. 

 

To add a Spider plot, either: 

 Click the  Spider plot icon on the VibroSight Vision toolbar. 

 Use the File > Add new plot > Spider plot VibroSight Vision menu command. 

 Use the Add new plot > Spider plot command in the VibroSight Vision Project Explorer tool 

window and (right-click on a View and use the shortcut menu that appears). 

 

To add measurement data to a Spider plot: 

 Select one or more scalar measurements in the Hardware view or Machinery view and drag it to 

the Spider plot. (A Time Range must also be selected before VibroSight Vision can display a plot.) 

 Drag additional measurements the Spider plot (or use ALT+double-click), as required. 

 

 

2.31 Cursor synchronisation 

Cursor synchronisation across all plot types has been added to VibroSight Vision. 

(Previously, cursor synchronisation was only supported in a single plot type, for example, between the 

different charts of a Bode plot or between the waveforms and orbit of an Orbit plot.) 

Cursor synchronisation is intended to be used to help quickly find corresponding information in other 

measurements after particular data of interest is found in one plot. This allows all of the information 

relevant to a particular event or time period be more easily displayed and analysed together in more 

detail, for example, by using different plots, different types of plot, different measurement points and 

so on. 

For example, a useful way of working with Long Waveform plots is in combination with a (standard) 

Waveform plot, and with cursor synchronisation between the plots. 
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To work with cursor synchronisation across different plots: 

1. Ensure that two or more plots are displayed. 

2. For each plot to use cursor synchronisation: 

Select the plot and ensure that Main cursor and Synchronise cursors are enabled: 

 When a plot is selected, click  on the VibroSight Vision toolbar to enable 

the Main cursor (the toolbar button should change to  ). 

 When a plot is selected, click  on the VibroSight Vision toolbar to enable 

Synchronise cursors (the toolbar button should change to  ). 

3. Navigate through one of the plots with cursor synchronisation enabled using the cursor, for 

example, click and drag the cursor using the mouse pointer or use one of the VibroSight Vision 

keyboard shortcuts. 

Note that in the other plots with cursor synchronisation enabled, their cursor automatically tracks 

the cursor being moved by the user. Accordingly, the information displayed in the Legend at the 

bottom of each plot document window also synchronises to display information for the 

measurement at the cursor. 

 

NOTE: Cursor synchronisation (and zoom synchronisation) is now enabled by default in all 

plot types. 

 

If required, the default plot settings for VibroSight Vision plots can be changed in order to not use 

cursor synchronisation by default: 

1. Click the Tools > Options menu command. 

2. The Options window for VibroSight Vision is displayed. 

3. Select Default Plot Settings in the Options window (left pane). 

4. In the default plot settings displayed in the Options window (right pane), on the General tab, under 

Synchronisation, clear the Synchronise cursors control in order to disable cursor synchronisation 

by default, then click OK. 

The updated default settings configured for VibroSight Vision plots will be used the next time that a 

new plot document window is created. 

See also 2.32 Zoom synchronisation. 
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2.32 Zoom synchronisation 

Zoom synchronisation has been added to VibroSight Vision. 

Zoom synchronisation is intended to be used to help display corresponding information at a similar 

level of detail in other similar plots after particular data of interest is found in one plot. This allows the 

information relevant to a particular event or time period be more easily displayed and analysed 

together in detail, for example, by using different plots, different types of plot, different measurement 

points and so on. 

NOTE: Zoom synchronisation is similar to cursor synchronisation, but while cursor 

synchronisation depends on the Y-axis only, zoom synchronisation depends on the 

X-axis and the Y-axis. 

 

To work with zoom synchronisation across different plots: 

1. Ensure that two or more plots are displayed. 

2. For each plot to use zoom synchronisation: 

Select the plot and ensure that Synchronise zoom is enabled: 

 When a plot is selected, click  on the VibroSight Vision toolbar to enable 

the Synchronise zoom (the toolbar button should change to  ). 

3. In one of the plots with zoom synchronisation enabled: 

Use the  Zoom mode control on the VibroSight Vision toolbar to select one of the zoom 

modes: Frame zoom, Vertical zoom or Horizontal zoom. 

Click and drag the area of the plot to zoom in on using the mouse pointer. 

Note that in all of the plots with zoom synchronisation enabled, the plots update to use equivalent 

zoom areas, depending on the plot types. 

4. If required, repeat the clicking and dragging of an area of the plot to zoom in more. 

5. When required, use the  Zoom reset control on the VibroSight Vision toolbar to reset the 

zoom and display the plots without zoom. 

 

NOTE: Zoom synchronisation (and cursor synchronisation) is now enabled by default in all 

plot types. 

 

If required, the default plot settings for VibroSight Vision plots can be changed in order to not use 

zoom synchronisation by default: 

5. Click the Tools > Options menu command. 

6. The Options window for VibroSight Vision is displayed. 

7. Select Default Plot Settings in the Options window (left pane). 
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8. In the default plot settings displayed in the Options window (right pane), on the General tab, under 

Synchronisation, clear the Synchronise zoom control in order to disable zoom synchronisation by 

default, then click OK. 

The updated default settings configured for VibroSight Vision plots will be used the next time that a 

new plot document window is created. 

See also 2.31 Cursor synchronisation. 

 

 

VM600 cards 

2.33 XMx16 cards: Customer-specific processing 

VM600 XMx16 card firmware now supports customer-specific functionality that is enabled by a 

customer-specific VibroSight software licence. 

Therefore, a firmware upgrade is required in order to run VibroSight 3.0.0. 

NOTE: In order to run VibroSight 3.0.0 for machinery monitoring systems containing 

VM600 XMx16 cards, a firmware upgrade to the latest version of XMx16 card 

firmware is required. See 5.2 VM600 cards. 

 

As the only change to the VM600 XMx16 card firmware is customer-specific functionality that is 

enabled by a customer-specific VibroSight software licence, most users will not see any changes in 

the operation of the XMx16 card or their machinery monitoring systems. 
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3 Solved problems and bug fixes 

General 

3.1 Improvements and bug fixes 

General stability improvements across the VibroSight 3.0.0 software. 
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4 Known issues 

4.1 Display of timestamps in VibroSight Vision 

In VibroSight Vision, when the timestamps (date and time) are configured to be displayed as Site time 

or Local computer time and the site time or local computer time is subsequently changed on the 

relevant computer (for example, using Windows > Control Panel > Date and Time), this change is not 

reflected in the VibroSight Vision user interface until the user clicks on the Timestamp displayed in 

the VibroSight Vision status bar. 

 

4.2 VibroSight Server and Host Service restart required after changes to 
network adapter 

If the configuration of a network adapter is changed (for example, enabled or disabled, connected or 

disconnected) on a computer running VibroSight, then the VibroSight Servers and Host Services 

running on the computer must be restarted in order for the network adapter to be recognized by the 

VibroSight discovery mechanism. 

 

4.3 Length limitation of VibroSight Server instance names 

Since VibroSight 2.9.6, VibroSight Server instance names are limited to 18 characters, whereas up to 

27 characters were allowed in previous versions. This constraint is enforced during the creation of new 

server instances with VibroSight 2.9.6 or later. 

NOTE: VibroSight allows only alphanumeric characters (A to Z, a to z, 0 to 9), the 

hyphen-minus character ( - ) and the underscore character ( _ ) to be used for 

VibroSight Server names. 

 

However, existing server instances may be non-compliant (too long) and no longer run after an 

upgrade of the VibroSight software. In such cases, the file names used for the VibroSight Server 

database file (*.vssrvdb or *.db) and the VibroSight Server configuration file (*.vssrvcfg or 

*.config) should be updated (and manually edited in the VibroSight configuration file) to be 

18 characters or less. Changes may also be required in any VibroSight software that references the 

server instance name, such as VibroSight Vision projects. 

Where used, the automated database copies append a timestamp (_yyyyMMddHHmmss) to the 

Server instance name which reduces the number of file name characters that remain available for 

VibroSight Server instance names to three. Alternatively, the server instance name can be shorted 

after the database copy is complete. 

Also, depending on the VibroSight Server database file names used and any truncation performed by 

VibroSight, it is possible that servers are created with names that contain non-allowed characters 

(such as spaces), with the result that these servers will not be accessible by VibroSight software 

clients. Similarly, duplicate VibroSight Server names are also possible. 
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NOTE: Choose appropriate VibroSight Server names in order to avoid name conflicts 

arising due to truncation and/or additional databases being created during 

automatic data management. 

This is particularly important for systems with automated data management and 

system backup procedures that use script files containing database commands 

(such as copy and backup) that can automatically generate VibroSight Server 

database files. 

 

4.4 VibroSight client connections to local and remote VibroSight Servers are 
mutually exclusive 

When a VibroSight Server is running on a (local) computer, a VibroSight client, such as VibroSight 

Configurator or VibroSight Vision running on the same (local) computer cannot connect to a VibroSight 

Server running on a different (remote) computer. 

 

4.5 VibroSight Servers listen to a single IP address 

A VibroSight Server uses one specific IP address for connections to VibroSight clients and all 

communications is directed through this VibroSight Server IP address. This IP address can be set to 

any of the available network adapters or logical addresses on the host computer running the 

VibroSight Server. On a computer with a single network adapter, the IP address of the single network 

adapter is used by default. 

In typical applications, the network adapter of the host computer running the VibroSight Server is 

connected to a dedicated control (industrial) Ethernet network that contains the VibroSight-compatible 

hardware such as VM600 XMx16 cards and VibroSmart devices. 

However, as a VibroSight Server uses one specific IP address (network adapter), this prevents 

concurrent connections from VibroSight clients running on other separate networks, such as a 

business (corporate) Ethernet network. 

See also 4.11 VibroSight Server communication errors. 

 

4.6 Display of timestamps in VibroSight clients other than VibroSight Vision 

Although VibroSight Vision now supports the display of timestamps (date and time) as either Site time, 

UTC time or Local computer time, all other VibroSight client software modules continue to display 

timestamps in local computer time only (that is, the date and time according to the local clock of the 

computer running the VibroSight software module). 

 

4.7 Display of devices in VibroSight System Manager 

In the System Explorer window of VibroSight System Manager, the Devices tree-view does not always 

update correctly to show all of the devices (VM600 cards and VibroSmart devices) available on the 

network. 
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In particular, this has been seen when changing the firmware of a device, and can persist even after a 

refresh (using the Refresh toolbar button or View > Refresh). 

If this behaviour is seen, the recommended workaround is to: 

 Wait a few minutes and refresh again. 

 Restart VibroSight System Manager. 

 

4.8 VibroSight Mimic backwards compatibility 

VibroSight 2.10.0 contained significant improvements and changes, including a separate VibroSight 

Mimic client software module for mimics (that were previously available in VibroSight Vision). As a 

result, VibroSight Vision mimics created with VibroSight 2.9.7 or earlier are not compatible with 

VibroSight 2.10.0 or later. 

VibroSight 2.11.0 contained significant improvements and changes to the VibroSight Mimic client 

software module. As a result, VibroSight Vision mimics created with VibroSight 2.10.1 or earlier are 

not compatible with VibroSight 2.11.0 or later. 

VibroSight 2.11.5 contained significant improvements to the VibroSight Mimic project framework to 

include version information, in order to improve the compatibility between projects created with 

different versions of VibroSight Mimic and eliminate the requirement for the recreation of Mimics. 

Starting with VibroSight 2.11.5, Mimic projects automatically detect any changes in the VibroSight 

Mimic software that affect project compatibility, inform the user and update the project as required. 

NOTE: VibroSight 2.11.5 is also able to open and work with Mimic projects created with 

VibroSight 2.11.0 or later, if the corresponding database had been updated as 

required. 

 

4.9 VibroSight OPC Clients not recovering 

When a VibroSight OPC Client is being used to import information from an external OPC server into a 

VibroSight system and the external OPC server becomes unavailable, the VibroSight OPC Client may 

not always recover automatically when the OPC server becomes available again. 

This is typically characterised by the VibroSight OPC Client continuing to show connection error 

messages even when OPC server is available and can result in permanent loss of the imported data if 

not noticed. 

NOTE: The external OPC data can be permanently lost if it is not imported into VibroSight 

as expected. 

Any VibroSight system feature or configuration element relying on the imported 

OPC data will not behave as expected, for example, alarms, machinery operating 

conditions and data logging rules. 
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If this behaviour is seen, the recommended workaround is to: 

 Stop and restart the VibroSight OPC Client from either the VibroSight Server 

(Data > Acquisition > OPC Device Driver) or VibroSight System Manager. 

 Stop and restart the VibroSight Server, if required. 

4.10 Duplicate events 

For VibroSight systems using VM600 XMx16 cards, VibroSight Event Viewer retrieves all of the event 

information available from the data buffers on the cards. 

For VibroSight systems using VibroSmart modules, VibroSight Event Viewer retrieves the event 

information available from the current time only (no buffered events). 

Accordingly, for a VibroSight system using VM600 XMx16 cards, there is the possibility of duplicate 

events being listed in the Event Viewer, particularly for VibroSight systems being operated without an 

NTP server (where events are not recognised as duplicates due to time drift). 

 

4.11 VibroSight Server communication errors 

Under rare circumstances, when a computer running VibroSight clients has two network adapters 

(cards) installed, communications errors with a VibroSight Server are possible. 

See also 4.5 VibroSight Servers listen to a single IP address. 

 

4.12 VibroSight Server status indicators 

The status indicators (performance counter monitors) on the Status tab of the new VibroSight Server 

are not correctly displayed and updated when an NVIDIA WMI driver is installed on the same 

computer as the VibroSight Server. 

NOTE: The NVIDIA Enterprise Management Toolkit (NVWMI) is a graphics and display 

management and control technology that interfaces to Microsoft’s Windows 

Management Instrumentation (WMI) infrastructure, specific to NVIDIA graphics 

processing units (GPUs). 

 

This is because NVIDIA WMI prevents the Microsoft .NET Framework from obtaining the required 

counter values from the underlying operating system / computer. 

See also 2.13 New VibroSight Server. 
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4.13 XMx16 card pre-logging 

For an XMx16 card pair, if Dynamic Input Channel 16 is used as an input to a Dynamic Processing 

Block that is used as an input to a Dual Shaft Relative Processing Block which is configured to provide 

an Orbit and/or Full Spectrum output, then any pre-logging configured for the principal mode 

Waveform and/or Spectrum of Dynamic Input Channel 16 will not actually log any of the data from the 

same pre-logging scope. 
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5 Compatibility 

As part of the VibroSight software installation process, the VibroSight installer will automatically check 

to see if the required Microsoft .NET Framework (see section 5.1.2), Microsoft Visual C++ 

Redistributable Package (see section 5.1.3) and OPC Core Components Redistributable 

(see section 5.1.4) are pre-installed. 

The required Microsoft .NET Framework and Microsoft Visual C++ Redistributable Package must be 

manually installed on the computer before VibroSight can be installed. If the required Microsoft .NET 

Framework and Microsoft Visual C++ Redistributable Package are not pre-installed, then the 

VibroSight installer will detect this and exit the installation. 

If not already installed, the required OPC Core Components Redistributable software is automatically 

installed on the computer by the VibroSight installer. 

NOTE: Refer to the latest version of the  Getting started with VibroSight installation 

guide or the  VibroSight software data sheet for further information on 

VibroSight’s prerequisites and compatibility. 

 

5.1 VibroSight software 

VibroSight 3.0.0 is a major level release, the first in the 3.x.x series, and replaces VibroSight 2.12.7. 

Compatibility with existing VibroSight data repositories (databases) is achieved using a specific data 

migration process from any existing databases based on Sybase SQL Anywhere (*.vssrvdb) to data 

repositories based on the VibroSight historical data repositories (VibroSight historical data folders 

(*.vshdf) for operation with a VibroSight Server (live data) and VibroSight historical data archives 

(*.vshda) for operation with historical data). 

Therefore, it is important to note that: 

 New machinery monitoring projects created with VibroSight 3.0.0 will automatically use VibroSight 

historical data repositories. 

 Existing machinery monitoring projects created with versions of VibroSight earlier than 

VibroSight 3.0.0 must be manually migrated from Sybase SQL Anywhere databases to VibroSight 

historical data repositories before they can be used with VibroSight 3.0.0. 

NOTE: The manual migration of an existing machinery monitoring project to 

VibroSight 3.0.0 is described in detail in the “Data migration” section of the latest 

 Getting started with VibroSight installation guide 

(MSS document ref. 660-010-006-217A). 
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5.1.1 Microsoft Windows operating systems 

VibroSight 3.0.0 is compatible with 32-bit versions and 64-bit versions of Microsoft ® Windows ® 

operating systems. 

NOTE: Starting with VibroSight 3.0.0, VibroSight software is now available as 64-bit 

software for 64-bit Windows and 32-bit software for 32-bit Windows. 

The 64-bit version of VibroSight can be installed on 64-bit Windows computers 

only. The 32-bit version of VibroSight can be installed on 32-bit Windows 

computers only.Only a single version of VibroSight can be installed and exist on a 

computer at any one time 

 

See the appendix of this document for detailed information on VibroSight software and Windows 

operating system compatibility. 

5.1.2 Microsoft .NET Framework 

For most Windows operating systems, VibroSight 3.0.0 requires that the Microsoft .NET 

Framework 4.6 or later is installed. 

NOTE: VibroSight 3.0.0 requires Microsoft .NET Framework 4.6. 

 

If the required Microsoft .NET Framework is not pre-installed, then the VibroSight installer will detect 

this and exit the installation. 

See the appendix of this document for detailed information on VibroSight software’s Microsoft .NET 

Framework requirements. 

 

5.1.3 Microsoft Visual C++ Redistributable Package 

VibroSight 3.0.0 requires that the Microsoft Visual C++ Redistributable Package for Visual Studio 2015 

is installed, in order to install and register the Visual C++ libraries used by VibroSight. 

NOTE: The 64-bit version of the Microsoft Visual C++ Redistributable Package (“Microsoft 

Visual C++ 2015 Redistributable (x64)”) must be installed on 64-bit Windows 

computers. 

The 32-bit version of the Microsoft Visual C++ Redistributable Package (“Microsoft 

Visual C++ 2015 Redistributable (x86)”) must be installed on 32-bit Windows 

computers. 

 

If the required Microsoft Visual C++ Redistributable Package is not pre-installed, then the VibroSight 

installer will detect this and exit the installation. 
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5.1.4 OPC Core Components Redistributable 

VibroSight 3.0.0 requires that the OPC Core Components Redistributable is installed, in order to 

configure and run VibroSight OPC Clients and VibroSight OPC Servers correctly: the redistributable 

must be installed on OPC client computers in order to allow connections to remote OPC servers and it 

must be installed on OPC server computers in order to allow OPC clients to browse for running OPC 

servers. 

NOTE: The 64-bit version of the OPC Core Components Redistributable (“OPC Core 

Components Redistributable (x64) 106.0”) must be installed on 64-bit Windows 

computers. 

The 32-bit version of the OPC Core Components Redistributable (“OPC Core 

Components Redistributable (x86) 106.0”) must be installed on 32-bit Windows 

computers. 

 

If the required OPC Core Components Redistributable is not pre-installed, then the VibroSight installer 

will detect this and automatically install it as part of the VibroSight software installation. 

 

5.1.5 Sybase SQL Anywhere 11 software 

Starting with VibroSight 3.0.0, the VibroSight historical data repositories (VibroSight historical data 

folders (*.vshdf) for operation with a VibroSight Server (live data) and VibroSight historical data 

archives (*.vshda) for operation with historical data) are exclusively used for the required data 

repositories. 

A VibroSight database based on Sybase SQL Anywhere (*.vssrvdb) can no longer be used as a 

data repository. Accordingly, the Sybase SQL Anywhere 11 database software is no longer included 

and distributed as part of the VibroSight software. 

NOTE: VibroSight 3.0.0 exclusively uses data repositories based on the VibroSight 

historical data system. 

VibroSight 2.12.7 used data repositories based on Sybase SQL Anywhere 

databases and introduced initial support for working with data repositories based 

on the VibroSight historical data repositories for data analysis. 

VibroSight 2.12.6 or earlier exclusively used data repositories based on Sybase 

SQL Anywhere databases. 

 

NOTE: The manual migration of an existing machinery monitoring project to 

VibroSight 3.0.0 is described in detail in the “Data migration” section of the latest 

 Getting started with VibroSight installation guide 

(MSS document ref. 660-010-006-217A). 
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5.1.6 VM600 CMS software 

The VM600 CMS software from Meggitt Sensing Systems uses Sybase SQL Anywhere 8. Both 

Sybase SQL Anywhere 8 (VM600 CMS) and Sybase SQL Anywhere 11 (VibroSight) can be installed 

on the same computer. 

However, while SQL Anywhere 8 and SQL Anywhere 11 can be installed on the same computer and 

run at the same time for standard database operations, certain administrative tasks are mutually 

exclusive and may block one another. 

More specifically, all operations that refer to Sybase SQL (a command-line Interactive SQL utility) in 

the background could be directed to the wrong version of Sybase SQL Anywhere. For example, this 

impacts all user operations and system operations involving the creation, copying and updating of 

databases. 

NOTE: It is recommended to install and use VibroSight 2.12.7 or earlier on a computer that 

does not have the VM600 CMS software installed. 

 

5.1.7 SIMATIC Step 7 software 

The SIMATIC Step 7 software from Siemens typically uses Sybase SQL Anywhere 9. Both Sybase 

SQL Anywhere 9 (SIMATIC Step 7) and Sybase SQL Anywhere 11 (VibroSight) can be installed on 

the same computer. 

However, while SQL Anywhere 9 and SQL Anywhere 11 can be installed on the same computer, they 

cannot run at the same time. 

More specifically, if SIMATIC Step 7 and VibroSight are both installed, certain administrative tasks, 

such as all user operations and system operations involving the creation, copying and updating of 

databases, may not work correctly. If this behaviour is seen, the recommended workaround is to 

manually change or remove the SQLANY environmental variable in order to allow VibroSight to work 

correctly. 

Note: The SQLANY environment variable is used to contain the directory where Sybase SQL 

Anywhere is installed. 

NOTE: It is recommended to install and use VibroSight 2.12.7 on a computer that does not 

have the SIMATIC Step 7 software installed. 
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5.2 VM600 cards 

5.2.1 Firmware 

There are firmware updates for some VM600 cards corresponding to VibroSight 3.0.0. 

 

The latest firmware for the CPUR remains: 

 Base System: base-system-640-014-001-001.tgz 

 Applications:  applications-640-015-001-001.tgz. 

Therefore, for current versions of the VM600 CPUR card, a firmware upgrade is not required. 

 

The latest firmware for the XMC16, XMV16 and XMVS16 is now: 

 Base System: base-system-640-003-001-014.tgz 

 Applications:  applications-640-010-001-014.tgz. 

Improvements to this latest VM600 XMx16 card firmware includes support for customer-specific 

functionality that is enabled by a customer-specific VibroSight software licence (see 2.33 XMx16 

cards: Customer-specific processing for further information). 

NOTE: In order to run VibroSight 3.0.0 for machinery monitoring systems containing 

VM600 XMx16 cards, a firmware upgrade to the latest version of XMx16 card 

firmware is required. See 6.2 Updating VibroSight-compatible hardware. 

 

 

5.3 VibroSmart devices 

5.3.1 Firmware 

There are no firmware updates for VibroSmart modules and devices corresponding to 

VibroSight 3.0.0. 

The latest firmware for the VSI010 module remains: 

 642-002-000-009.xmsifw. 

The latest firmware for the VSN010 device remains: 

 642-004-000-011.redboxfw. 

The latest firmware for the VSV300 module remains: 

 642-001-000-014.xtranfw. 

Therefore, for current versions of the VibroSmart modules and devices, firmware upgrades are not 

required. 
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6 Upgrade procedure 

This section describes the procedure for upgrading a VibroSight system from a previous version. 

Perform the steps in the given sequence in order to complete a system upgrade. 

NOTE: It is strongly recommended to verify the version of firmware running in the related 

hardware (XMx16 cards and VibroSmart modules and devices) before starting a 

VibroSight system upgrade, in order to establish if any firmware updates are also 

required. 

See 6.2.3 Updating the firmware using VibroSight System Manager. 

 

NOTE: It is strongly recommended to ensure that a copy of the configuration for a 

VibroSmart is available before updating the firmware of any of the VibroSmart 

modules used in the distributed monitoring system. See 6.2.3 Updating the 

firmware using VibroSight System Manager. 

 

6.1 VibroSight software user settings 

The VibroSight Software generates and uses some files on the hard disk of the computer running 

VibroSight to keep track of user-configurable settings, so that these settings are remembered and 

applied for the VibroSight installation. 

These settings files have an .xmssettings file name extension and on a computer running 

Windows 7, can be found here: 

C:\Users\username\AppData\Roaming\Meggitt\VibroSight, where username is the Windows 

account name. 

For example, the VibroSightVision.xmssettings file records the user-configurable default 

settings for VibroSight Vision, such as default settings for plots. 

NOTE: VibroSight software updates and upgrades do not replace these settings files, so: 

• For a computer on which VibroSight was previously installed, an update, upgrade 

or a re-installation of VibroSight will continue to use the previous defaults recorded 

in the .xmssettings files. 

• For a computer on which VibroSight was not previously installed, the installation 

of VibroSight will generate and use new .xmssettings files, which use the latest 

VibroSight software defaults. 

If a settings file is deleted for any reason, VibroSight will generate and use a new 

settings file, which uses the latest VibroSight software defaults. 
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6.2 Updating VibroSight-compatible hardware 

Appropriate files and tools are included in the installation package to allow VM600 cards (XMx16) and 

VibroSmart devices (VSI010, VSN010 and VSV300) to be updated to the latest firmware, in order to 

take advantage of improvements to the VibroSight software. 

Updating the firmware VM600 cards or VibroSmart devices is a special task that can, if used 

unintentionally or incorrectly, lead to malfunctioning of the device and affect proper function of data 

acquisition. 

During the firmware update of a device, the card or module being updated cannot provide its normal 

machinery monitoring functions because its outputs (alarms and relays) can go to undetermined 

states, irrespective of how they have been configured. 

For VibroSmart modules, the machinery being monitored is not protected for the duration of a firmware 

update and the restart (reboot) that is triggered automatically after the firmware update (which can 

take up to 5 minutes). 

NOTE: It is highly recommended that firmware updates are only performed in accordance 

with the operating procedures for the machinery being monitored and that 

appropriate precautions are taken at the control system level (such as DCS 

or PLC). 

For example, alarms and relay outputs should be ignored (bypassed or inhibited) in 

order to avoid false trips of the machinery being monitored. 

 

6.2.1 VM600 card firmware 

The latest VM600 card firmware files are copied to a directory on your computer as part of the 

VibroSight software installation process. 

NOTE: For example, the default firmware directory for VM600 cards is: 

C:\Program Files\Meggitt\VibroSight\Firmware\VM600 

 

The firmware files for a VM600 card can be found in the appropriate subfolder and identified by their 

.tgz file name extension. For example, the XMV16 subfolder contains the applications and base 

system firmware for use by XMV16 cards. Any additional firmware updates received from Meggitt 

Sensing Systems should also be stored in these directories. 

Table 1 shows the compatibility between VibroSight software and VM600 CPUR card hardware (that 

is, CPUR card firmware). 

Table 2 shows the compatibility between VibroSight software and VM600 XMx16 card hardware (that 

is, XMC16, XMV16 and XMVS16 card firmware). 

NOTE: It is strongly recommended to use the most recent version of the VM600 CPUR 

card firmware and VM600 XMx16 card firmware that is compatible with the version 

of VibroSight software being used. 
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Table 1: VibroSight software and VM600 CPUR card firmware compatibility 

 VM600 CPUR firmware. See note 1 

VibroSight software version 

CD part number 

Base-system (*.tgz) 

640-014-001-001 

Applications (*.tgz) 

640-015-001-001 

2.12.7 

609-004-000-036 
 

See note 2
 

3.0.0 

609-004-000-037 
 

 

Notes for Table 1 

1. VM600 CPUR card firmware is packaged and distributed as a .tgz file (a compressed archive file format) with PNRs such as 

640-014-001-xxx for the Base System and 640-015-001-xxx for the (Applications) Firmware. In these PNRs, the xxx-xxx-001-

xxx denotes the firmware is packaged in the tgz file format. 

After the .tgz file is unpacked by VibroSight System Manager and the firmware is uploaded to a VM600 CPUR card, the dialog 

box displayed by the VibroSight System Manager’s Change Firmware command shows the current version of firmware using 

PNRs such as 640-014-000-xxx for the Base System and 640-015-000-xxx for the Firmware, which correspond to the actual 

unpacked firmware that is running on the card. 

 

2. This is the first official release of VM600 CPUR card firmware and includes features such as the management of XMx16 card 

configurations for applications such as control systems and the implementation of the PROFIBUS protocol for the fieldbus 

interfaces. A firmware upgrade is required in order to run VibroSight 2.12.7. 
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Table 2: VibroSight software and VM600 XMx16 card firmware compatibility 

 VM600 XMx16 firmware. See note 1 

VibroSight 

software version 

CD part number 

Base-system (*.tgz) 

640-003- 

001-011 

640-003- 

001-012 

640-003- 

001-013 

640-003- 

001-014 

Applications (*.tgz) 

640-010- 

001-010 

640-010- 

001-011 

640-010- 

001-012 

640-010- 

001-013 

640-010- 

001-014 

2.12.0 

609-004-000-027 
 

See note 2
 

    

2.12.1 

609-004-000-028 
  

See note 3
  

See note 4
 

  

2.12.2 

609-004-000-029 
   

  

2.12.3 

609-004-000-030 
   

  

2.12.4 

609-004-000-032 
   

  

2.12.5 

609-004-000-033 
   

  

2.12.6 

609-004-000-034 
   

  

2.12.7 

609-004-000-036 
    

See note 5
  

3.0.0 

609-004-000-037 
     

See note 6
 

 

Notes for Table 2 (see the next page)  
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Notes for Table 2 

1. VM600 XMx16 card firmware is packaged and distributed as a .tgz file (a compressed archive file format) with PNRs such as 

640-003-001-xxx for the Base System and 640-010-001-xxx for the (Applications) Firmware. In these PNRs, the xxx-xxx-001-

xxx denotes the firmware is packaged in the tgz file format. 

After the .tgz file is unpacked by VibroSight System Manager and the firmware is uploaded to a VM600 XMx16 card, the dialog 

box displayed by the VibroSight System Manager’s Change Firmware command shows the current version of firmware using 

PNRs such as 640-010-000-xxx for the Firmware and 640-003-000-xxx for the Base System, which correspond to the actual 

unpacked firmware that is running on the card. 

 

2. This version of VM600 XMx16 card firmware introduces support for hydro air-gap monitoring. 

 

3. This version of VM600 XMx16 card firmware introduces support for 1 s time-boxed peak-hold processing (that is, spectral 

data aggregation). 

 

4. This version of VM600 XMx16 card firmware implements improved multi-rate digital resamplers (sample rate converters). 

A firmware upgrade is recommended but not required in order to run VibroSight 2.12.5. 

 

5. This version of VM600 XMx16 card firmware improves support for faster live data: 100 ms card update rate and up to 100 ms 

VibroSight Vision refresh rate. It also allows a VM600 XMx16 card to be managed by a VM600 CPUR card (“rack controller”), 

eliminating the XMx16 card’s requirement for a VibroSight Server. A firmware upgrade is required in order to run 

VibroSight 2.12.7. 

 

6. This version of VM600 XMx16 card firmware adds support for customer-specific functionality that is enabled by a customer-

specific VibroSight software licence. A firmware upgrade is required in order to run VibroSight 3.0.0. 
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6.2.2 VibroSmart device firmware 

The latest VibroSmart device firmware files are copied to a directory on your computer as part of the 

VibroSight software installation process. 

NOTE: The default firmware directory for VibroSmart devices is: 

C:\Program Files\Meggitt\VibroSight\Firmware\VibroSmart 

 

The firmware files for a VibroSmart device can be found in the appropriate subfolder and identified by 

their .*fw file name extension. For example, the VSV300 subfolder contains the firmware for use by 

VSV300 modules. Any additional firmware updates received from Meggitt Sensing Systems should 

also be stored in these directories. 

Table 3 shows the compatibility between VibroSight software and the VibroSmart VSI010 module 

firmware. 

Table 4 shows the compatibility between VibroSight software and the VibroSmart VSN010 device 

firmware. 

Table 5 shows the compatibility between VibroSight software and the VibroSmart VSV300 module 

firmware. 

 

NOTE: It is strongly recommended to use the most recent version of the VibroSmart 

firmware that is compatible with the version of VibroSight software being used. 
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Table 3: VibroSight software and VibroSmart VSI010 module firmware compatibility 

 VSI010 firmware (*.xmsifw). See note 1 

VibroSight 

software version 

CD part number 

642-002 

-000-006 

642-002- 

000-007 

642-002- 

000-008 

642-002- 

000-009 

2.12.0 

609-004-000-027 


 See note 2
 

   

2.12.1 

609-004-000-028 
 

 See note 2
 

  

2.12.2 

609-004-000-029 
  

  

2.12.3 

609-004-000-030 
  

 See note 2
 

 

2.12.4 

609-004-000-032 
   

 

2.12.5 

609-004-000-033 
   

 

2.12.6 

609-004-000-034 
   

 See note 2
 

2.12.7 

609-004-000-036 
    

3.0.0 

609-004-000-037 
    

 

 

Notes for Table 3 

1. VibroSmart VSI010 module firmware is distributed as a single .xmsifw file (a proprietary file format) with a PNR such as 642-

xxx-000-xxx. In these PNRs, the xxx-xxx-000-xxx denotes that the firmware is not packaged (compressed or archived). 

VibroSight System Manager always uses and displays information about VibroSmart device firmware using PNRs such as 642-

xxx-000-xxx, which correspond to the actual firmware that is running on the device. 

 

2. Updating to this version of VibroSmart VSI010 firmware requires a specific process: 

Notes: 

For a VibroSmart consisting of different types of device, the devices should be updated in the following order: first VSN010 real-

time Ethernet switches, then VSV300 vibration monitoring modules and finally VSI010 communications interface modules. In 

addition, VibroSight System Manager should be exited (closed) and restarted after updating the firmware for each type of 

device, before continuing. And after updating the firmware, the configuration on the VibroSmart devices should be re-activated 

and the VibroSmart devices should be restarted. 
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Procedure: 

(1) Ensure that a copy of the configuration for the VibroSmart is available before updating any device firmware. For example, 

using the currently installed version of VibroSight (that is, before any updates to the VibroSight software corresponding to 

updates to VibroSmart devices), VibroSight Configurator can be used to obtain a copy of the configuration as follows: 

• For a VibroSmart using a VibroSight Server, the File > Open > Server / Database command can be used to read the 

configuration from the VibroSight Server. 

• For a VibroSmart not using a VibroSight Server (that is, a “stand-alone” VibroSmart), the File > Open > Device command can 

be used to read the configuration directly from the VibroSmart modules. 

Then the File > Save As > File command can be used to store a copy of the configuration for the VibroSmart. 

 (2) Start VibroSight System Manager, select the device or devices of the same type to be updated (for example, VSI010 

modules) and run the Change Firmware command. 

When updating multiple VibroSmart devices of the same type to use the same firmware, CTRL+click or SHIFT+click can be 

used to select multiple devices in the Devices tree structure of the System Explorer window. This way, when the Change 

Firmware command is run, all of devices that were selected will be updated at the same time. Otherwise, each device must be 

selected and updated individually. 

(3) When the VibroSmart Module(s) Firmware Upgrade window displays a “Firmware upgrade terminated. The firmware has 

been upgraded successfully …” message, click the Finish button to continue. 

If after 10 minutes, the VibroSmart Module(s) Firmware Upgrade window does not display a successful message, click the 

Cancel button to close the window and continue. 

Then exit (close) VibroSight System Manager. 

(4) Restart VibroSight System Manager and verify that the correct version of firmware is reported for each device that was 

updated. (When a device is selected in the System Explorer window, this information is available in the main window (centre) 

under Module PNR. It is also available in the VibroSmart Module(s) Firmware Upgrade window when a device is selected and 

the Change Firmware command is run). 

If a device does not report the correct version of firmware, rerun the Change Firmware command for this device. 

Then exit (close) VibroSight System Manager. 

(5) Repeat steps (2), (3) and (4) for each type of device to be updated (for example, VSN010 and VSV300 modules). 

(6) Start VibroSight Configurator, open the configuration for the VibroSmart (see step (1)), then activate the configuration. (If 

required, VibroSight Configurator will automatically update the configuration to the latest version and inform the user.) 

Then exit (close) VibroSight Configurator. 

(7) Turn the power supply to the VibroSmart off and wait for a few seconds. Then turn the power supply back on and verify that 

the system operates as expected. 

During this firmware update process, the behaviour of the LEDs on the front panel of the VibroSmart devices can be 

inconsistent and should be ignored. Normal LED behaviour resumes after the firmware update is complete (after step (7)). 
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Table 4: VibroSight software and VibroSmart VSN010 device firmware compatibility 

 VSN010 firmware (*.redboxfw). See note 1 

VibroSight 

software 

version 

CD part number 

642-004- 

000-008 

642-004- 

000-009 

642-004- 

000-010 

642-004- 

000-011 

2.12.0 

609-004-000-027 


 See note 2
 

   

2.12.1 

609-004-000-028 
 

 See note 2
 

  

2.12.2 

609-004-000-029 
  

  

2.12.3 

609-004-000-030 
  

 See note 2
 

 

2.12.4 

609-004-000-032 
   

 

2.12.5 

609-004-000-033 
   

 

2.12.6 

609-004-000-034 
   

 See note 2
 

2.12.7 

609-004-000-036 
    

3.0.0 

609-004-000-037 
    

 

 

Notes for Table 4 

1. VibroSmart VSN010 device firmware is distributed as a single .redboxfw file (a proprietary file format) with a PNR such as 

642-xxx-000-xxx. In these PNRs, the xxx-xxx-000-xxx denotes that the firmware is not packaged (compressed or archived). 

VibroSight System Manager always uses and displays information about VibroSmart device firmware using PNRs such as 642-

xxx-000-xxx, which correspond to the actual firmware that is running on the device. 

 

2. Updating to this version of VibroSmart VSN010 firmware requires a specific process: 

Notes: 

For a VibroSmart consisting of different types of device, the devices should be updated in the following order: first VSN010 real-

time Ethernet switches, then VSV300 vibration monitoring modules and finally VSI010 communications interface modules. In 

addition, VibroSight System Manager should be exited (closed) and restarted after updating the firmware for each type of 

device, before continuing. And after updating the firmware, the configuration on the VibroSmart devices should be re-activated 

and the VibroSmart devices should be restarted. 
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Procedure: 

(1) Ensure that a copy of the configuration for the VibroSmart is available before updating any device firmware. For example, 

using the currently installed version of VibroSight (that is, before any updates to the VibroSight software corresponding to 

updates to VibroSmart devices), VibroSight Configurator can be used to obtain a copy of the configuration as follows: 

• For a VibroSmart using a VibroSight Server, the File > Open > Server / Database command can be used to read the 

configuration from the VibroSight Server. 

• For a VibroSmart not using a VibroSight Server (that is, a “stand-alone” VibroSmart), the File > Open > Device command can 

be used to read the configuration directly from the VibroSmart modules. 

Then the File > Save As > File command can be used to store a copy of the configuration for the VibroSmart. 

 (2) Start VibroSight System Manager, select the device or devices of the same type to be updated (for example, VSN010 

modules) and run the Change Firmware command. 

When updating multiple VibroSmart devices of the same type to use the same firmware, CTRL+click or SHIFT+click can be 

used to select multiple devices in the Devices tree structure of the System Explorer window. This way, when the Change 

Firmware command is run, all of devices that were selected will be updated at the same time. Otherwise, each device must be 

selected and updated individually. 

(3) When the VibroSmart Module(s) Firmware Upgrade window displays a “Firmware upgrade terminated. The firmware has 

been upgraded successfully …” message, click the Finish button to continue. 

If after 10 minutes, the VibroSmart Module(s) Firmware Upgrade window does not display a successful message, click the 

Cancel button to close the window and continue. 

Then exit (close) VibroSight System Manager. 

(4) Restart VibroSight System Manager and verify that the correct version of firmware is reported for each device that was 

updated. (When a device is selected in the System Explorer window, this information is available in the main window (centre) 

under Module PNR. It is also available in the VibroSmart Module(s) Firmware Upgrade window when a device is selected and 

the Change Firmware command is run). 

If a device does not report the correct version of firmware, rerun the Change Firmware command for this device. 

Then exit (close) VibroSight System Manager. 

(5) Repeat steps (2), (3) and (4) for each type of device to be updated (for example, VSI010 and VSV300 modules). 

(6) Start VibroSight Configurator, open the configuration for the VibroSmart (see step (1)), then activate the configuration. (If 

required, VibroSight Configurator will automatically update the configuration to the latest version and inform the user.) 

Then exit (close) VibroSight Configurator. 

(7) Turn the power supply to the VibroSmart off and wait for a few seconds. Then turn the power supply back on and verify that 

the system operates as expected. 

During this firmware update process, the behaviour of the LEDs on the front panel of the VibroSmart devices can be 

inconsistent and should be ignored. Normal LED behaviour resumes after the firmware update is complete (after step (7)). 
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Table 5: VibroSight software and VibroSmart VSV300 module firmware compatibility 

 VSV300 firmware (*.xtranfw). See note 1 

VibroSight 

software version 

CD part number 

642-001-000-

010 

642-001-

000-011 

642-001-

000-012 

642-001-

000-013 

642-001-

000-014 

2.12.0 

609-004-000-027 


 See note 2
 

    

2.12.1 

609-004-000-028 
 

 See note 2
 

   

2.12.2 

609-004-000-029 
  

   

2.12.3 

609-004-000-030 
  

 See note 2
 

 See note 2
 

 See note 2
 

2.12.4 

609-004-000-032 
     

2.12.5 

609-004-000-033 
     

2.12.6 

609-004-000-034 
     

2.12.7 

609-004-000-036 
     

3.0.0 

609-004-000-037 
     

 

 

Notes for Table 5 

1. VibroSmart VSV300 device firmware is distributed as a single .xtranfw file (a proprietary file format) with a PNR such as 642-

xxx-000-xxx. In these PNRs, the xxx-xxx-000-xxx denotes that the firmware is not packaged (compressed or archived). 

VibroSight System Manager always uses and displays information about VibroSmart device firmware using PNRs such as 642-

xxx-000-xxx, which correspond to the actual firmware that is running on the device. 

 

2. Updating to this version of VibroSmart VSV300 firmware requires a specific process: 

Notes: 

For a VibroSmart consisting of different types of device, the devices should be updated in the following order: first VSN010 real-

time Ethernet switches, then VSV300 vibration monitoring modules and finally VSI010 communications interface modules. In 

addition, VibroSight System Manager should be exited (closed) and restarted after updating the firmware for each type of 

device, before continuing. And after updating the firmware, the configuration on the VibroSmart devices should be re-activated 

and the VibroSmart devices should be restarted. 
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Procedure: 

(1) Ensure that a copy of the configuration for the VibroSmart is available before updating any device firmware. For example, 

using the currently installed version of VibroSight (that is, before any updates to the VibroSight software corresponding to 

updates to VibroSmart devices), VibroSight Configurator can be used to obtain a copy of the configuration as follows: 

• For a VibroSmart using a VibroSight Server, the File > Open > Server / Database command can be used to read the 

configuration from the VibroSight Server. 

• For a VibroSmart not using a VibroSight Server (that is, a “stand-alone” VibroSmart), the File > Open > Device command can 

be used to read the configuration directly from the VibroSmart modules. 

Then the File > Save As > File command can be used to store a copy of the configuration for the VibroSmart. 

 (2) Start VibroSight System Manager, select the device or devices of the same type to be updated (for example, VSV300 

modules) and run the Change Firmware command. 

When updating multiple VibroSmart devices of the same type to use the same firmware, CTRL+click or SHIFT+click can be 

used to select multiple devices in the Devices tree structure of the System Explorer window. This way, when the Change 

Firmware command is run, all of devices that were selected will be updated at the same time. Otherwise, each device must be 

selected and updated individually. 

(3) When the VibroSmart Module(s) Firmware Upgrade window displays a “Firmware upgrade terminated. The firmware has 

been upgraded successfully …” message, click the Finish button to continue. 

If after 10 minutes, the VibroSmart Module(s) Firmware Upgrade window does not display a successful message, click the 

Cancel button to close the window and continue. 

Then exit (close) VibroSight System Manager. 

(4) Restart VibroSight System Manager and verify that the correct version of firmware is reported for each device that was 

updated. (When a device is selected in the System Explorer window, this information is available in the main window (centre) 

under Module PNR. It is also available in the VibroSmart Module(s) Firmware Upgrade window when a device is selected and 

the Change Firmware command is run). 

If a device does not report the correct version of firmware, rerun the Change Firmware command for this device. 

Then exit (close) VibroSight System Manager. 

(5) Repeat steps (2), (3) and (4) for each type of device to be updated (for example, VSI010 and VSN010 modules). 

(6) Start VibroSight Configurator, open the configuration for the VibroSmart (see step (1)), then activate the configuration. (If 

required, VibroSight Configurator will automatically update the configuration to the latest version and inform the user.) 

Then exit (close) VibroSight Configurator. 

(7) Turn the power supply to the VibroSmart off and wait for a few seconds. Then turn the power supply back on and verify that 

the system operates as expected. 

During this firmware update process, the behaviour of the LEDs on the front panel of the VibroSmart devices can be 

inconsistent and should be ignored. Normal LED behaviour resumes after the firmware update is complete (after step (7)). 
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6.2.3 Updating the firmware using VibroSight System Manager 

When performing VibroSight software upgrades, it is strongly recommended to systematically upgrade 

the firmware of VM600 XMx16 cards and VibroSmart devices to the latest compatible version. 

Failure to perform a necessary VibroSight-compatible VM600 card firmware update may lead to 

incoherent system behaviour and affect the proper functioning of data acquisition in a system. It is only 

in systems where the firmware running on the XMx16 cards and VibroSmart devices already 

corresponds to the latest available version that no firmware update is required. Therefore, it is strongly 

recommended to verify the version of firmware running on the hardware before starting a VibroSight 

system upgrade, in order to establish if a firmware update is also required. 

NOTE: Changing the firmware of the VibroSight hardware is a special administrative task 

that can – if performed unintentionally – affect the proper functioning of data 

acquisition in a system. 

It is therefore strongly recommended to change the firmware of the VibroSight 

hardware only when it is necessary. For example, when the devices must be 

updated to be compatible with a VibroSight software upgrade. 

 

For VibroSmart modules, each module can be selected and its firmware updated individually. 

Alternatively, multiple modules of the same type (for example, VSV3x0) can be updated to the same 

version of firmware at the same time. 

NOTE: It is strongly recommended to ensure that a copy of the configuration for a 

VibroSmart is available before updating the firmware of any of the VibroSmart 

modules used in the distributed monitoring system. 

For example, using the currently installed version of VibroSight (that is, before any 

updates to the VibroSight software corresponding to updates to VibroSmart 

modules), VibroSight Configurator should be used to obtain a copy of the 

configuration as follows:  

For a VibroSmart using a VibroSight Server, the File > Open > Server / Database 

command can be used to read the configuration from the VibroSight Server. 

For a VibroSmart not using a VibroSight Server (that is, a “stand-alone” 

VibroSmart), the File > Open > Device command can be used to read the 

configuration directly from the VibroSmart modules. 

Then the File > Save As > File command should be used to store a copy of the 

configuration for the VibroSmart distributed monitoring system. 

 

Update the firmware on a VibroSight device using the  Change Firmware tool (from VibroSight 

System Manager’s Maintenance tools): 

1. Ensure that the computer running the VibroSight software is on the same network as the 

hardware (XMx16 card or VibroSmart module or device) to be updated. 

2. Start VibroSight System Manager and navigate to the Devices tree structure in the System 

Explorer window. 
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The Devices tree lists all of the VibroSight compatible hardware that VibroSight can see on the 

network. If there are no XMx16 cards or VibroSmart devices in the tree structure or some cards 

are missing, verify your network connections. 

3. Select the card or device that requires its firmware to be changed. 

The Actions tool window updates to show the available tools. 

To change multiple VibroSmart to use the same version of firmware at the same time, use 

CTRL+click or SHIFT+click to select multiple devices from the Devices tree-view. (Then, when 

the Change Firmware command is run, all of the devices that were selected will be updated at 

the same time.) 

4. Click  Change Firmware in the Maintenance tools group of the Actions window. 

The Change Firmware dialog box appears. 

5. Click the Add button and select the new firmware files for the card or new firmware file for the 

device. 

 NOTE: The Change Firmware dialog box automatically opens the firmware folder 

corresponding to the VibroSight-compatible VM600 card or VibroSmart device 

selected. 

.tgz files are for VM600 cards and .*fw files are for VibroSmart devices. 

 

6. Click the Finish button to start the firmware upgrade process. 

For XMx16 cards and VibroSmart devices, the firmware upgrade process can take up to 

5 minutes, during which: 

 The IP address beside the device’s serial number in the Devices tree structure can 

disappear. 

 The LEDs on the front panel of the device can change to reflect the status of the upgrade. 

7. Repeat steps 3 to 6 for each device that requires a firmware update. 

 NOTE: Although the firmware for each VibroSight device must be changed individually 

using the  Change Firmware tool, as each device updates its firmware 

independently of the VibroSight software (once the process has started), firmware 

updates can be performed on several devices in parallel. 

 

8. After the firmware upgrade, verify that the VibroSight system is acquiring data from the cards. 

 NOTE: Refer also to the Changing the firmware topics in the  VibroSight help. 

 

The  Change Firmware tool can be used to load a VibroSight device with any version of 

firmware. It is therefore possible to change a device’s firmware to any previously available version, as 

well as the latest update. 
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This feature can be useful in certain situations, for example, swapping spare VibroSight hardware 

between different VM600 racks or VibroSmart distributed monitoring systems, where systems are 

operating with different versions of VibroSight. 

 

6.3 Final checks 

After upgrading the VibroSight software, the following checks are recommended to ensure that 

VibroSight has not been inadvertently modified and that it continues to operate as expected: 

 Use VibroSight Configurator to run a consistency check on the configuration in order to ensure 

that the configuration has not been modified by any changes to the VibroSight software, 

internal database structure and firmware for the hardware (VM600 cards and VibroSmart 

modules). 

 Use the VibroSight Server window to check that the data acquisition, data post-processing and 

data logging settings are as expected. 

In VibroSight Server, under Device drivers, use the appropriate controls to enable 

communications with the VibroSight-compatible hardware, and under Server features, use 

the appropriate controls to enable the required post processing, for example, data logging. 
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7 Customer support 

7.1 Contacting us 

Meggitt Sensing Systems worldwide customer support network offers a range of support including 

Technical support and Sales and repairs support. For customer support, please contact your local 

Meggitt Sensing Systems representative. Alternatively, contact our main office: 

Customer support 

Meggitt SA 

Route de Moncor 4 

PO Box 1616 

CH-1701 Fribourg 

Switzerland 

 

Telephone: +41 (0) 26 407 11 11 

Email: energysupport@ch.meggitt.com 

Web: www.meggittsensingsystems.com 

 

7.2 Technical support 

Meggitt Sensing Systems technical support team provide both pre-sales and post-sales technical 

support, including: 

 General advice 

 Technical advice 

 Troubleshooting 

 Site visits. 

 

7.3 Sales and repairs support 

Meggitt Sensing Systems sales team provide both pre-sales and post-sales support, including advice 

on: 

 New products 

 Spare parts 

 Repairs. 

 

mailto:energysupport@ch.meggitt.com
http://www.meggittsensingsystems.com/
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Appendix 
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 VibroSight software and Windows operating system compatibility 

 Windows Vista 
Windows 7 and 

Windows Server 2008 R2 

Windows 8, Windows 10 and 

Windows Server 2012 

VibroSight software compatible? 
Yes, but not recommended for new 

installations as Microsoft support for 

Windows Vista ends in April 2017. 

Yes – recommended for new 

installations 
To be announced 

 

 

 Microsoft .NET Framework versions pre-installed on Windows operating systems 

 Windows Vista 
Windows 7 and 

Windows Server 2008 R2 

Windows 8 and 

Windows Server 2012 

Microsoft .NET Framework 

pre-installed on 

Windows operating system 

.NET Framework 3.0 .NET Framework 3.5 SP1 .NET Framework 4.5 
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 VibroSight software’s Microsoft .NET Framework requirements 

VibroSight software version Microsoft. NET Framework requirements 

VibroSight 2.9.1 or earlier .NET Framework 3.5 SP1 

VibroSight 2.9.2 and 2.9.3 .NET Framework 4 (Standalone Installer) 

VibroSight 2.9.4 or later .NET Framework 4.5 

VibroSight 2.12.0 or later .NET Framework 4.5 and .NET Framework 2.0 
See note

 

VibroSight 3.0.0 .NET Framework 4.6 

Note: Since Microsoft .NET Framework 3.5 also includes .NET Framework 2.0 and .NET Framework 3.0, installing Microsoft .NET Framework 3.5 SP1 is the recommended 

solution for most computers (rather than installing Microsoft .NET Framework 2.0). 
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